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CHAPTER 1

Introduction

1.1 OVERVIEW

IMPORTANT: onsemi acknowledges that this document might contain the inappropriate terms “white list",
"master" and "slave”. We have a plan to work with other companies to identify an industry wide solution that
can eradicate non-inclusive terminology but maintains the technical relationship of the original wording. Once
new terminologies are agreed upon, future products will contain new terminology.

RSL10 is a multi-protocol, Bluetooth® 5 certified, radio System on Chip (SoC), with the lowest power
consumption in the industry. It is designed to be used in devices that require high performance and advanced wireless
features, with minimal system size and maximized battery life. The RSL10 Software Development Kit (SDK) includes
firmware, software, example projects, documentation, and development tools. The Eclipse-based onsemi Integrated
Development Environment (IDE) is offered as a free download with optional support for Arm® Keil® uVision® and
TAR Embedded Workbench®.

Software components, device and board support information are delivered using the CMSIS-Pack standard.
Standard CMSIS-Drivers for peripheral interfaces and FreeRTOS sample applications are supported. With the
CMSIS-Pack standard, you can easily go beyond what is included in our software package and have access to a variety
of generic Cortex-M software components. If you have existing RSL10 projects and have not used the RSL10
CMSIS-Pack before, see Appendix A, “Migrating to CMSIS-Pack” on page 53 for more information.

The RSL10 SDK allows for rapid development of ultra-low power Bluetooth Low Energy applications. Convenient
abstraction decouples user application code from system code, allowing for simple modular code design. Features such
as FOTA (Firmware Over-the-Air) can easily be added to any application. Advanced debugging features such as
support for SEGGER® RTT help developers monitor and debug code. Sample applications, from Blinky to
ble peripheral server bond and everything in between, help get software development moving quickly. An optional
Bluetooth mesh networking CMSIS-Pack quickly enables mesh networking for any application. Android and iOS
mobile apps are available on their respective app stores to demonstrate and explore RSL10 features.

This document helps you to get started with the RSL10 SDK. It guides you through the process of connecting your
RSL10 Evaluation and Development Board, installing an IDE and the CMSIS-Pack, configuring your environment, and
building and debugging your first RSL10 application.

NOTE: RSLI10 contains a low power DSP processor core; see RSL10 LPDSP32 Software Package.zip for
more information.

1.2 INTENDED AUDIENCE

This manual is for people who intend to develop applications for RSL10. It assumes that you are familiar with
software development activities.

1.3 CONVENTIONS

The following conventions are used in this manual to signify particular types of information:
monospace Commands and their options, error messages, code samples and code snippets.

mono bold A placeholder for the specified information. For example, replace £ilename with the actual
name of the file.
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bold Graphical user interface labels, such as those for menus, menu items and buttons.

italics File names and path names, or any portion of them.
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CHAPTER 2

Setting Up the Hardware

2.1 Prerequisite Hardware

The following items are needed before you can make connections:

*  RSL10 Evaluation and Development Board and a micro USB cable
* A computer running Windows

2.2 CONNECTING THE HARDWARE
To connect the Evaluation and Development Board to a computer:
1. Check the jumper positions:
Ensure that the jumper CURRENT is connected and POWER OPTIONS is selected for USB. Also, connect the

jumpers TMS, TCK and SWD. Finally, connect the headers P7, P8, P9 and P10 to 3.3 V, as highlighted in
Figure 1.

JTAG MCU

Figure 1. Evaluation and Development Board with Pins and Jumpers for Connection Highlighted

2. Once the jumpers are in the right positions, you can plug the micro USB cable into the socket on the board.
The LED close to the USB connector flashes green during the first time plugging in, then turns a steady green
once the process is finished.

2.3 PRELOADED SAMPLE

The Evaluation and Development Boards come with one of the following preloaded sample applications:

www.onsemi.com
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*  “Peripheral Device with Sleep Mode” is on boards with a serial number lower than 174 1xxxxx.
o “Peripheral Device with Server” is on boards with a serial number higher than 1741xxxxx.

For more information about sample applications, refer to the RSL10 Sample Code User’s Guide.

www.onsemi.com
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CHAPTER 3

Getting Started with the Eclipse-Based onsemi IDE

3.1 SOFTWARE TO DOWNLOAD

1. Download the onsemi IDE Installer from.www.onsemi.com/RST10.

2. Download the RSL10 Software Package from www.onsemi.com/RSL 10 and extract the RSL10 CMSIS-Pack
(ONSemiconductor.RSL10.<version>.pack) to any temporary folder. (The temporary folder can be on any
drive on your computer.)

3. Make sure your J-Link software is version 7.66b or higher.

3.2 oNseMI IDE AND RSL10 CMSIS-PACK INSTALLATION PROCEDURES

For instructions on installing the onsemi IDE, see the onsemi Installation Instructions and Release Notes
document.

To install the RSL10 CMSIS-Pack:

1. Itis important to create a new workspace for each new version of the IDE to ensure compatibility. Create a
new workspace at, for example, c:\workspace — using either Windows Explorer or the onsemi Launcher in
step 2.

2. Open the onsemi IDE by going to the Windows Start menu and selecting onsemi > onsemi IDE. From the
onsemi IDE Launcher screen, browse to your new workspace, select it, and click Launch.

3. On the top row of the Workbench perspective, click the “Make the CMSIS Packs Manager perspective visible”
icon (see Figure 2).

NOTE: If you cannot see the CMSIS-Pack Manager item, re-install the IDE in your user folder (i.e.,

C:\Users\cuser name>).

o | i@ v 6l

T

Figure 2. Opening the CMSIS-Pack Manager Perspective

4. Click on the Import Existing Packs icon, select your pack file ONSemiconductor\RSL10\<version>\pack,
where <version> is a number such as 3.1.575, and click Open (see Figure 3).

www.onsemi.com
8


https://www.onsemi.com/rsl10
https://www.onsemi.com/rsl10

onsemi
RSL10 Getting Started Guide

= Import Packs
v 1 « Program Files (x86) > RSL10_Software_Package ~w Q) Search RSL10 Software Packa.. P
o Organize ~ New folder =~ M o
T ZRIR A TRAS § TR )
firmware_referer ™ Name Date modified Type S

Fo. VR N - = .
F [ @ 8 =
= | & R 2 [ | ¢ Getting Started [ ] ONSemiconductorRSL10.3.1.575.pack 2019-09-23 5:25 PM PACK File

hardware_refere

| Import Existing Packs...

&+ Dropbox
r. Please import your CMSIS-Pack & OneDrive
%= Kenichi
e vl € >
File name: |ONSemiconductor.RSL10.3.1.575.pack V‘ ‘PackFlIe;("pack) ~

Figure 3. Installing the RSL10 CMSIS-Pack

5. The IDE installs the RSL10 CMSIS-Pack in the specified pack root folder.

6. Read the license agreement, Software Use Agreement - use and accept (ONIPLAW 08142020).pdf, found in
the root directory of the installed CMSIS-Pack.

7. The RSL10 CMSIS-Pack now appears in the list of installed packs. In the Devices tab, if you expand All
Devices > onsemi > RSL10 Series you can see RSL10 listed there. You can manage your installed packs in
the Packs tab. Expanding ONSemiconductor > RSL10 makes the Pack Properties tab display the details of
the RSL10 CMSIS-Pack. Figure 4 illustrates what the Pack Manager perspective looks like after installation.
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= Workspace_2019-11-18 - ON Semiconductor IDE

File Edit Navigate Search Project Run Window Help
‘ | | ‘ [¥) H L] ‘ - ~ || No Launch Configurations v }Dﬂ]\“- vt BEifdBmi Qi s
T |zl
B Devices 2 | B Boards HE|% @ Y =0 @Ppacks 2 FE| & BuF|®@ ¥ = 0 =packProperties 8 — O
Search Device Search Pack HE|® ¥
P P v type filter text
Device Summary Pack Action Description
~ % All Devices 1 Device ~ *® Device Specific 1 Pack RSL10 selected ~ H ONSemiconductor.RSL10.
~ % ONSemiconductor 1 Device « % ONSemiconductor.RSL10 2 Up te daf ON Semiconductor RSL10 Device Family Pack Bl Boards
v % RSL10 Series 1 Device 31575 1% Remove  Release notes available at www.onsemi.com/rsl10 4 Components
B RrsL10 ARM Cortex-M3 48 MHz, 24 Kl * Generic Software Packs with generic content not specific to B Devices
™ Examples
< > || | < >
& Console & REE MBE-my=0
CMSIS Cansole

Figure 4. Pack Manager Perspective after RSL10 CMSIS-Pack is Installed

3.3 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE ONSEMI IDE

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIO6) blink on the Evaluation and Development Board.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.

3.3.1 Launching the onsemi IDE

Open the onsemi IDE by going to the Windows Start menu and selecting onsemi > onsemi IDE.
3.3.2 Importing the Sample Code

Import the sample code as follows:

In the Pack Manager perspective, click on the Examples tab to list all the example projects included in the
RSL10 CMSIS-Pack.

Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 5).
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= Workspace_2019-11-18 - ON Semiconductor IDE
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M Devices 5 B Boards HE|%|® Y = 8  @packs [ Examples 2 = O | = pack Properties 2
Search Device Only show examples from installed packs ‘ Ea = TR ‘ @Y ERE]
Device Summary Search Example type filter text
~ T All Devices 1 Device Example Action Description A | |~ B ONSemicondut
v % ONsemiconductor 1 Device 2 ADC_UART (RSL10 Evaluation Board) (@ Gopy. | ADC with UART Sample Code » B Boards
~ T RSL10Series 1 Device © aes128 (RSL10 Evaluation Board) [ Copy. . AES128 - Simple AES-128 Sample & Component
B rsiio ARM Cortex-M3 48 MHz, 24 KB RAM, £ ble_android_asha (RSL10 Evaluation B/& Copy Android Audio Streaming Hearing ’ : Devices
< ble_central_client_bond (RSL10 Evalua g Copy. BLE Central Client Bonding Sampl & Bamples
£ ble_central_client_scan (RSL10 Evaluati/ i Central Device with Client Scanne:

S ble_central_peripheral (RSL10 Evaluati g Copy. Central Peripheral Device Sample
< ble_peripheral_server_bond (RSL10 Ev: & éé& BLE Peripheral Server Bonding Sal
S ble_peripheral_server_hrp (RSL10 Evalt@._ Copy Heart Rate Peripheral Device with
© ble_peripheral_server_hrp_fota (RSL10 L.‘ m. Heart Rate Peripheral Device with
< ble_peripheral_server_PRA (RSL10 Evalﬁ' @ a Private resolvable Address with Se
£ blinky (RSL10 Evaluation Board) &Cop: Blinky GPIO 1/O Sample Code

= bootloader (RSL10 Evaluation Board) g m " Bootloader Sample Code

& central_client_uart (RSL10 Evaluation B/ i Central Device with Client UART S
& custom_protocol_trx (RSL10 Evaluatior g Copy. Low Latency Audio Sample Applii
& default MANU_INFO_INIT (RSL10 EvalL& éé& Default System Initialization Func
& dma_driver (RSL10 Evaluation Board) @._ Copy DMA Driver Sample Code

£ DMIC_OD (RSL10 Evaluation Board) L.‘ QM. DMIC and OD Sample Code

& flash_copier_and_crc (RSL10 £va|uati0:& @ a Flash Copier and CRC Sample Coc
£ freertos_ble_central_client_bond (RSL1 @75%7 BLE Central Client Bonding Sampl
S freertos_ble_peripheral_server_bond (F Q_m_ BLE Peripheral Server Bonding Sai o

< > < 3 <

Bl Console & =3 Progress BB MY
CMSIS Consale

Figure 5. Pack Manager Perspective: Examples Tab

3. The C/C++ perspective opens and displays your newly copied project. In the Project Explorer panel, you can
expand your project folder and explore the files inside your project. On the right side, the blinky.rteconfig file
displays software components. If you expand Device > Libraries, you can see the System library (libsyslib)
and the Startup (libcmsis) components selected for blinky (see Figure 6).
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File Edit Scurce Refactor MNavigale Search Project Run Windew Help
X0 = - ~ || No Launch Configurations ~ ol --- (s | BBl w| @i @ r ey~ o g
3
v filwr S |Quick Aceess| | = | |Gl 8
{5 Project Explorer £ = 0O § blinkyrteconfig =i0 B e, ot . e =8
sk Lt 4 Components | @ L
i blinky : . There is na active editor that provides an
) Includes Soltware Components  Sel. Variant Vendor Version  Description cirfine
s include: B s OnSemiconduc ARM Cosrten-M3 &8 MHy, 24 KB RAM, 381
& AT # CMSIS Driver
R appe ~ % Dence
@ viinky.rieconti * Bluetooth Core §/ 100 re implementation
[ readme_blinky.md * Bluetoath Profie
v # Libraries
¥ Catibrate O  source ONSemiconduc 31575
# Customn Prator] source ONS, 31575 Litrary
¥ DMA O  source ONSemiconduc 3.1.575
# Flash O source ONSermconduc 3.1.575
¥ GPID O source OMSermiconduc 3.1.575
# Math 0O source OnSemiconduc 31575
# gemote Mic [0 source OfSemicondue 31575 cliby
# Syctem B source ONSemiconduc 3.1.575 |, System Macros a
* Startup i source C 31575, Systern Startup for ON 5110
Validation Cutput Description
Companents | Device Packs|
£ Problems & Console = Fropeni 3w o0
0 iterns
Description Resource Path Location Type

Figure 6. RTE Configuration for the Blinky Example Project in the onsemi IDE

3.3.3 Build the Sample Code

Follow these steps to build the sample code:

1. Right click on the folder for blinky and click Build Project. Alternatively, you can select the project and click
the Build Project icon, which looks like a hammer, as shown in Figure 7.

www.onsemi.com
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File Edit Source Refactor MNawigate Search Project Run Window Help

o = | No Launch Configurations ~ | on A w54 BrfQrLiQin| gy GO SS
- Bl - - Quick Access) | o | (B @y
i Project Explarer & = 8 4 blinky.rteconfig & =B Eowm. o b =a
New » | @ -
v &bl | There is no active editor that provides an
Go Into Bl variant Vendor Version  Deseription .
E autline.
= Openin New Window ANSemiconduc ARM Cortex-M3 4B MHz, 24 KB RAM, 368 KB ROM
= Show in Local Terminal o
Le Coy
il 100 L BIEC plementa
Source ' 5 | source ONSemiconduc 3.1.575
P source ONSemicondue 31575 Libiary
— o source ONSemiconduc 3.1.575
= source ONSemiconduc 31575
4 Impaort.. source ONSemiconduc 3.1.575
e Export. source ONSemiconduc 3.1.575
& CM5I5 C/C++ Project * sOurce OMNSemiconduc 3.1.575
Build Project source ONSemiconduc 3.1.575 nd Libr3
Clean Project SOUrcE ONSemiconduc 3.1.575 |, System Startup for ON Semiconductor RSL10
Refresh F5
Close Project Description
Close Unrelated Project
Build Targets 5
Indiex > |
Build Configurations * |
Profiling Tools »
O Run As ? pnsole L
% Debug As »
Profile Az v Resource Fath Location Type
‘ Restore fram Local History.

S blinky # f.un C/C++ Code Analysis . |

Figure 7. Starting to Build a Project in the onsemi IDE

2. When the build is running, the output of the build is shown in the onsemi IDE C/C++ Development Tooling
(CDT) Build Console, as illustrated in Figure 8.

Validation Qutput Description

Components Device | Packs
B &8 3| Q-

= Problems &) Tasks @ Console 0 O Properties
COT Build Cansole [blinky]
Invoking: Cross ARM GNU Create Flash Image
arm-none-eabi-objcopy -0 ihex “blinky,elf” “blinky, hex”
Finished building: blinky . hex
Invoking: Cross ARM GMU Print Size
arm-none-eabi-size --format=berkeley “blinky.elf®

text data bss dec hex filename

azed 180 1836 5348 ladc blinky.elf
Finished building: blinky.siz
13:52:29 Build Finished. ® errors, @ warnings. (took 7s.976ms)|

Figure 8. Example of Build Output

3. The key resulting output in Project Explorer, in the Debug folder, includes:
*  blinky.hex: HEX file for loading into Flash memory
+  blinky.elf: Arm® executable file, run from RAM, used for debugging
»  blinky.map: map file of the sections and memory usage

These files are shown in Figure 9.

NOTE: You might need to refresh the project to see the three built output files. To do so, right-click on
the project name blinky and choose Refresh from the menu.

www.onsemi.com
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File Edit Source Refactor Navigate Searc

o][=]|-- No Lz

: D e Bl - v
&5 Project Explorer 2 = 8  @blir
2% % v | &c

~ 12 blinky

" Binaries soft
& Includes L
~ = Debug 4
= RTE v &

app.o - [arm/le]
#¥ blinky.elf - [arm/le]
= appd
= blinky.hex
= blinky.map
® makefile
@ objects.mk
® sources.mk
® subdir.mk
= include
& RTE
¢ app.c
4 blinky.rteconfig

[*] readme_blinky.md Valic

Figure 9. Output Files from Building a Sample Project

3.4 DEBUGGING THE SAMPLE CODE

3.4.1 Debugging with the .elf File

Debug the application using the .elf file as follows:

1. Within the Project Explorer, right-click on the blinky.elf file and select Debug As > Debug
Configurations...

2. When the Debug Configurations dialog appears, right-click on GDB SEGGER J-Link Debugging and
select New Configuration. A new configuration for blinky appears under the GDB SEGGER heading, with
new configuration details in the right side panel.

3. Change to the Debugger tab, and enter RSL10 in the Device Name field. Ensure that SWD is selected as the
target interface (as shown in Figure 10).
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Create, manage, and run configurations ﬁ\

= > EEy =] _'.'> nir T
SECELN B3~ Name: ‘ blinky ‘
Liype fiter toxt '||B Main[$- Debugger & Startup % Source| T Common| 7, SVO Path| '
[E] C/C+ + Application | - Link GDB Server Setup "
[E] C/C++ Attach to Application Start the J-Link GDB server locally [“]Connect to running target
[€] €/C++ Container Launcher P I
Executable path: | S{jlink_path}/${jlink_gdbserver} Browse... | |Variables..

[E] C/C++ Postmortem Debugge
[£] C/C++ Remote Application Actual executable: | Cy/Program Files (x86)/SEGGER/JLink/JLinkGDBServerCLexe
G C/C++ Unit

[€] GDB Hardware Debugging

(to change it use the global or workspace preferences pages or the project properties page)

. i : -
[£] GDB OpenOCD Debugging Deyice narmic | R5L10 ‘ Supported device names
« [E] GDB SEGGER J-Link Debuggir | Endianness: @Litle  OBig
blinky Connection: [OIVS:] Qir I:l (USB serial or IP name/address)
4 Launch Group Interface: @®swp  OJTaG

b Ladnch Group (Deprecated) Initial speed: Oauto (O Adapts @ Fixed | 1000 |kHz

GDB port:

SWO port: [] Verify downloads Initialize registers on start
Telnet port: Local host only [Isilent
Log file; | Browse...
Other options: | -singlerun -strict -timeout 0 -nagui

Allocate console for the GDB server Allocate console for semihosting and SWO

GDB Client Setup

Executable name: | ${cross_prefixiadb${cross_suffix} Browse... |Variables..
< >
Filter matched 12 of 12 items Revert Apply
@ Close

Figure 10. Setting Up a GDB Launch Configuration, Debugger Tab

NOTE: To debug an application that does not start at the first address of flash memory, see Chapter 7,
“Advanced Debugging” on page 36.

4. Once the updates to the configuration are completed, make sure that the Evaluation and Development Board is
connected to the PC via a micro USB cable, and click Debug. J-Link automatically downloads the blinky
sample code to RSL10’s flash memory.

NOTE: IfJ-Link does not automatically write your program to RSL10’s flash memory, make sure you

are using a compatible J-Link version (see Section 3.2, “onsemi IDE and RSL10 CMSIS-Pack
Installation Procedures” on page 8).

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 7.4.1, “Downloading Firmware in Sleep Mode” on page 45.

5. You are prompted to switch to the debug perspective. Click Switch.

6. The Debug perspective opens and the application runs to main, as shown in Figure 11. You can press F6
multiple times to step through the code and observe that the LED changes its state when the application
executes the function Sys_GPIO Toggle (LED_DIO).
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~ o Thread #1 57005 (Suspended : led_toggle_status = 1; N
= main(] at app.c:124 (x10040 MName

o JLinkGDBServerCL.exe /* Initialize the system */

p| arm-none-eabi-gdb Initialize();
5| Semihosting and SWV /* Spin loop */
while (1)

/* Refresh the watchdog timer */
Sys_Watchdog_Refresh();

/* Toggle GPIO 6 (if toggling is enabled) then wait 8.5 s
if (led_toggle_status == 1)

{
Sys_GPIO_Toggle(LED DIO);
¥ £ >
else
Sys_GPIO_Set Low(LED_DIO);
¥
Sys_Delay_ProgramROM( (uint32_t)(@.5 * SystemCoreClock));
1 ' v
< >
& Console 2 Registers Problems Executables [g} Debugger Con = g8

- BEREE o
blinky [GDB SEGGER J-Link Debugging] JLinkGDBServerCL.exe
...Breakpoint reached @ address @xeeles4es A
Reading all registers
Read 4 bytes {@ address @x@@lee4ed (Data = @xF7FF2@86)

< I 4 >

Writable Smart Insert 124:1

Figure 11. Debug Perspective

3.4.2 Peripheral Registers View with the onsemi IDE

The onsemi IDE includes a peripheral register view plugin that enables you to visualize and modify all of the
RSL10 registers during a debug session. It can be configured by setting the path to the SVD file in the Debug session.

The following steps demonstrate how to configure and use the Peripheral Registers View with the Blinky
application:

1. Right click on the blinky.elf file, select Debug As > Debug Configurations, and open your configuration
details set, as described in Section 3.4.1, “Debugging with the .elf File” on page 14.

2. Change to the SVD Path tab, and set the path to the rsl10.svd file as
C:\Users\<username>\AppData\LocaNArm\Packs\ONSemiconductor\RSL10\<version>\svd\rs|10.svd (see
Figure 12). Click Debug.

www.onsemi.com
16



onsemi
RSL10 Getting Started Guide

= Debug Configurations

Create, manage, and run configurations ﬁ

CHeEX B3~ [ Name: ‘ blinky ||

bpe fltentext B Main | % Debugger\"b Startup | &~ Source [T Common |2, SVD Path |

C/C++ Application

C/C++ Attach to Application
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[€] GDB Hardware Debugging
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GDB SEGGER J-Link Debugging
[2] blinky
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B Launch Group (Deprecated)

<

Filter matched 12 of 12 items

SVD file (used by the peripheral registers viewer)
File path: ‘ CAUsers\[ [\ON_Semiconductor\PACK\ONSemiconductor\RSL10Y] [\svd | Browse... |Variables..

Revert Apply ‘

Figure 12. SVD Path Tab Debug Perspective

In the Debug perspective, when the application runs up to the first breakpoint in main, open the Peripherals
window view, by navigating to Window > Show View > Other > Debug > Peripherals and clicking Open.
Now you can see all the RSL10 peripherals displayed.

In the Peripherals window, select DIO. Open the Memory window to monitor the RSL10 peripheral. Read
only registers are highlighted in green. You might want to drag your Memory window and place it side-by-side
with your source code view (see Figure 13) to prevent the console from switching focus away from the
Memory window.

To see or change the DIO register status, choose DIO and expand the DIO > DIO_DATA register in the
Memory window.

Press F6 to step through the code. You can observe that this register’s bit 6 toggles its state when

Sys_GPIO Toggle (LED DIO) is executed (in this case, from 0xF060 to 0xF020). The register turns yellow
to indicate that you have activated real-time monitoring for it (see Figure 14 on page 18).
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7.

To manually change the register value, click on the Value field of the GPIO register to change the (HIGH/

LOW) state of GP106. Figure 14 shows the view before making the change, and Figure 15 illustrates the view
after making the change. You can observe that the LED (DIO6) on your board changes state.
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CHAPTER 4

Getting Started with Keil

4.1 PREREQUISITE SOFTWARE

1. Download and install the Keil nVision IDE from the Keil website, using the vendor’s instructions.

2. Download the RSL10 Software Package from www.onsemi.com/RSL 10 and extract the RSL10 CMSIS-Pack
(ONSemiconductor.RSL10.<version>.pack) to any temporary folder.

3. Make sure your J-Link software is version 7.66b or higher.

4.2 RSL10 CMSIS-PACK INSTALLATION PROCEDURE

To install the RSL10 CMSIS-Pack:

1. Open the Keil nVision IDE and navigate to Project > Manage > Pack Installer or click on the icon shown in
Figure 16.

File Edit View Project Flash Debug Peripherals Tools SVCS  Wine

== - ey Y | | m |;§;§G
& E 3 e |?§‘Target1 m#ﬁ‘ﬁ & @

Figure 16. Pack Installer Icon

2. Click on File > Import, select your pack file ONSemiconductor.RSL10.<versions>.pack, and click Open (sece
Figure 17). <version> is the RSL10 version, such as 2.2.347.

(&8 Import Packs =3
@Ow| » Computer » SYSTEM (C) » cmsis_pack Keil | 44 || Search emsis pack ket P|
Organize ~ New folder S 1 9
- Favorites *  Name Date modified Type
B Desktop % ONSemiconductor.RSL10.2.2.347 10/31/2018 429 PM  uVisior
: }4 Downloads
@ Pack Installer - C:\Keil_vS\ARM\PACK
=» Re it Pl
Packs Window Help ittt =
Refresh v
~| Libraries
Import... ET -
Import from Folder... % Documents
Manage Local Repositories... Pack 4. Music
B Summary De £, Pictures
[T TR RS 15734 Nevices = | - t Videos
& Computer
=¥ SYSTEM (C) e il b
File name: ONSemiconductor.RSL10.2.2.347 - [Sof‘tware Pack - PACK (*zip; ']
[ Open ‘VI | Cancel |

Figure 17. Installing the RSL10 CMSIS-Pack for the Keil uVision IDE

3. The IDE prompts you to read and accept our license agreement, then installs the RSL10 CMSIS-Pack in the
%LOCALAPPDATAY%\Arm\Packs folder.

4. After installation, use File > Refresh as shown in Figure 18 to update your pack proprieties.
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@ Pack Installer - C:\Keil_v5\ARM\PACK

Packs Window Help

Refresh

Import... IET

Import from Folder...

Manage Local Repositories... Pack
=-De

Evit Summary

Figure 18. Refresh Pack after installation

5. The RSL10 CMSIS-Pack now appears in the list of installed packs. In the Devices tab, if you expand All
Devices > ONSemiconductor > RSL10 Series, you can see RSL10 listed there. You can manage your
installed packs in the Packs tab. Expanding ONSemiconductor > RSL10 makes the Pack Properties tab
display the details of the RSL10 CMSIS-Pack. Figure 19 illustrates what the Pack Installer perspective looks

like after installation.

([ Pack Installer - C:\Keil vS\ARM\PACK
File Packs Window Help
{"_" Device: ONSemiconductor - RSL10

j Devices = Boards ﬂ j Packs / Examples
Search: - X | ]-— Show examples from installed Packs only
Device o | Summary | Example | Action Description

=% Maxim |9 Devices ;j ~ADC_UART (R5L10 Evaluation Board);@’ Co | ADC with UART S:
* MediaTek |2 Devices ' ble central_client bond (RSL10 Eval..| ¥ Copy | BLE Central Client
¥ Microchip .345 Devices ble_central_client scan (RSL10 Eval... & Copy | Pairing and Bondi
* Microsemi .6 Devices ble_peripheral_server_bond (RSL10 ‘..;@ Copy | BLE Peripheral Set
* MindMotion :2 Devices ~ble_peripheral_server_hrp (RSL10 Ev...i@’ Copy | Pairing and Bondi
* Nordic Semiconductor 13 Devices ~blinky (RSL10 Evaluation Board) & Copy | Blinky GPIO I/O Sz
¥ Nuvoton 487 Devices ~default MANU_INFO_INIT (RSL10 E... | Copy | Default System Ini
* NXP .1223 Devices ~hci_app (RSL10 Evaluation Board) & Co | Host Controlier Inv
¥ ONSemiconductor [1 Device i2c_cmsis_driver (RSL10 Evaluation ... % o | 12C CMSIS-Driver |
5% RSL10 Series .1 Device kernel_timer (RSL10 Evaluation Boa... & Copy | Kernel Timer Sam)
ARM Cortex-M3, 48 MHz ~measure_rc_osc (RSL10 Evaluation ... ;@ Coj | Measure 32 kHz R
|--% Redpine Signals .-2 Devices ~peripheral_server_standby (RSL10 E... |& Copy | Peripheral Device
¥ Renesas 4 Devices ~spi_cmsis_driver (RSL10 Evaluation ... ¥ o | SPI CMSIS-Driver !
* Silicon Labs 783 Devices ~supplemental_calibrate (RSL10 Eval... | Copy | Default System Ini
¥ Sinowealth .1 Device ~uart_cmsis_driver (RSL10 Evaluation... K3 Col UART CMSIS-Drive

* SONIX [50 Devices = ' '

¥ STMicroelectronics .1061 Devices
&% Texas Instruments ;_350 Devices Lj Il « ]

Output

Update available for Kell:ARM_Compiler (installed: 1.3.3, available: 1.4.0)
Update available for Keil:MDK-Middleware (installed: 7.5.0, available: 7.6.0)

Update available for ONSemiconductor:RSL10 (installed: 2.3.27, available: @version@)

Ready

Figure 19. Pack Installer after RSL10 CMSIS-Pack is Installed in the Keil nVision IDE

4.3 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE KEIL UVisiON IDE

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIO6) blink on the Evaluation and Development Board.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.
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4.3.1 Import the Sample Code

To import the sample code:

1. In the Pack installer, click on the Examples tab to list all the example projects included in the RSL10
CMSIS-Pack.

2. Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 20). Choose a destination folder for a copy of the sample code.

= Workspace_2019-11-18 - ON Semiconductor IDE

File Edit Navigate Search Project Run Window Help
@ ‘El i'“ \4 \ ' No Launch Configurations v | on: | --- vl
HR LA 2 - & - -

H Devices 2 H

HE %@ T 70 @aracks [ Examples &

Search Device Only show examples from |

e Summary Search Example
~ % All Devices 1 Device Example Action
~ ¥ ONSemiconductor 1 Device & ADC_UART (RSL10 Evaluation Board) [ Cop
v W RSL10Series 1 Device © aes128 (RSL10 Evaluation Board) [ Cop
B Rsii0 ARM Cortex-M3 48 MHz, 24 KERAM, : | @ ble_android_asha (RSL10 Evaluation B [ Cop

2 ble_central_client_bond (RSL10 Evalua ,Cn_;_g
& ble_central_client_scan (RSL10 Evaluati lg__('_oﬁ
& ble_central_peripheral (RSL10 Evaluati §
£ ble_peripheral_server_bond (RSL10 Ev: |
& ble_peripheral_server_hrp (RSL10 Evalt
& ble_peripheral_server_hrp_fota (RSL10 t.‘;._.E
& ble_peripheral_server PRA (RSL10 Eval @
© blinky (RSL10 Evaluation Board) % cop

Figure 20. Pack Manager Perspective: Examples Tab

Sample projects are preconfigured with release versions of RSL10 libraries, which are distributed as object files.

For Keil, System library (libsyslib) and Startup (libcmsis) are preconfigured with the source variant, so the source code
of those libraries is included directly (see Figure 21).
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Figure 21. RTE Configuration for the Blinky Example Project in the Keil nVision IDE

4.3.2 Build the Sample Code

Build the sample code as follows:

1. Right click on Target 1 and choose Rebuild all target files. Alternatively, you can use the icon shown in
Figure 22.
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
MNada s ai9 ¢ 1 = U5 | 2
\‘f @';ﬂlngarge‘tl F|$\|ﬁ%‘9@

Mo My

Praoject 1 @
=% Project: blinky
B4 Target 1 =
5.6 Source A% Options for Target ‘Target 1'... Alt+F7
a app.c Add Group...
=5 include &4 Manage Project Items...
3 app.h Open Map File
ER 4 Device Open Build Log
i rsI10_protocol.c #H Rebuild all target files
i rsl10_romvect.c [£ Build Target F7
% rs110_sys_asrc.c |7‘ Show Include File Dependencies

Figure 22. Starting to Build a Project in the Keil uVision IDE

2. When the build is running, the output of the build is shown in the Build Output view in the IDE, as illustrated
in Figure 23.
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Build Output

*** Oaing Compiler 'V5.06 update € (build 750)', folder: 'C:\Keil v5\ARM\ARMCC\Bin"
Build target 'Target 1°'

compiling app.c...

linking...

Program Size: Code=1508 RC-data=32 RW-data=4 ZI-data=3076

FromELF: creating hex file...

".\Cbjects\blinky.axf" - 0 Error(s), 0 Warning(s).

Build Time Elapsed: 00:00:02

Figure 23. Example of Build Output

3. The key resulting output in Project Explorer in the IDE includes:
»  blinky.hex: HEX file for loading into Flash memory
+  blinky.axf: Arm® executable file, run from RAM, used for debugging
»  blinky.map: map file of the sections and memory usage

4.3.3 Debugging the Sample Code

4.3.3.1 Preparing J-Link for Debugging

Before debugging with J-Link, go to C:\Keil_v5\ARM\Segger and make sure that the folder contains a JL2CM3.dll
file. As well, make sure that you have installed a compatible version of J-Link.

4.3.3.2 Debugging Applications
The IDE’s debug configurations are already set in the CMSIS-Pack. To debug an application:

1. Make sure the Evaluation and Development Board is connected to the PC via a micro USB cable.
2. Select Debug > Start/Stop Debug Session or click the icon shown in Figure 24.

File Edit View Project Flash [Debug | Peripherals Tools SVCS Window Help

= =] | 1 | @) Start/Stop Debug Session Ctri+F5  flconst union gapc d|~ | 54 ||
A ‘ o ‘ Targe y Energy Measurement without Debug
Project S5 Reset CPU

Figure 24. Start/Stop Debug Session Icon

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 7.4.1, “Downloading Firmware in Sleep Mode” on page 45.

3. The application runs up to the first breakpoint in main, as shown in Figure 25. You can press F11 multiple
times to step through the code and observe that the LED changes its state when the application executes the
function Sys _GPIO Toggle (LED DIO).
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File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
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; . 119 ) Watchd Ref hi):
ﬁ rsl10_sys_uart.c (Libraries:System) 120 ys_Watchdeg Refres 0
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= 12773 1 -
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Command a2 \§| Call Stack + Locals a2 \§|
777777777777 = .
Device: RSL10 Name Location/Value Type
VTarget = 3.300V ¥ main 0x00000000 int f()
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Figure 25. Debug Session in the Keil nVision IDE

NOTE: Debug configurations are preconfigured for the sample applications in the CMSIS-Pack. Flash
downloading through the Download icon (Figure 26) or F8 is not supported for J-Link.

| File | Edit View Project Flash Debug Peripherals

Target 1 m ES

Project

Figure 26. Download Button Not Supported for J-Link
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CHAPTER 5

Getting Started with 1AR

5.1 PREREQUISITE SOFTWARE

1. Download and install the IAR Embedded Workbench from the IAR Website, using the vendor’s instructions.

2. Download the RSL10 Software Package from www.onsemi.com/RSL 10 and extract the RSL10 CMSIS-Pack
(ONSemiconductor.RSL10.<version>.pack) to any temporary folder.

3. Make sure your J-Link software is version 7.66b or higher.

5.2 RSL10 CMSIS-PACK INSTALLATION PROCEDURE
To install the RSL10 CMSIS-Pack:
1. Open the IAR Embedded Workbench and expand File > New Workspace to open a new workspace, then go to

File > Save Workspace As and choose the location for your workspace.
2. Navigate to Project > CMSIS Pack Manager, or click on the icon shown in Figure 27.

File Edit View Project J-Link Tools Window Help
N A RS A% C 2 <Q>$x<8>00 o= 0 idd

Figure 27. Pack Installer Icon

3. Click on CMSIS Manager > Import Existing Packs, select your pack file
ONSemiconductor.RSL10.<version>.pack, and click Open (see Figure 28). <version> is the RSL10
version, such as 2.3.27.

a Import Packs @l
@Ov‘ | » Computer » SYSTEM (C:) » cmsis_pack IAR v| +p H Search cmsis_pack IAR P ‘
Organize ~ New folder o (2]
I Desktop *  Name Date modified Type
+ Downloads . - —
% ONSemiconductor.RSL10.2.3.27 pack 5/6/2019 2:43 PM uVisior
<» Recent Places
Libraries 3
*» Documents
& Music
. Pictures
i Videos
a IAR Embedded Workbench CMSIS Manager
File Edit Search | CMSIS Manager | Window Help LY Computer
: o N SR Apply RTE changes Ctrl+5Shift+S -j SYSTEM (C2) e T z T
Remove Unused Files
File name: ONSemiconductor.RSL10.2.3.27.pack - ‘Pack Files (*.pack) v|

Import Existing Packs
Import Packs from Folder

E @

l Open IVI| Cancel ‘

£

Create files from CMSIS Template...

o

Figure 28. Installing the RSL10 CMSIS-Pack for the IAR Embedded Workbench IDE

4. The IDE prompts you to read and accept the license agreement, then installs the RSL10 CMSIS-Pack in the
CMSIS-Pack root folder.

5. After installation, click on the refresh icon with yellow arrows, which shows the text Reload Packs in the
CMSIS Pack root folder when you hover over it with your cursor, in the Packs tab (as shown in Figure 29), to
update your pack proprieties.
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@ Packs 2 M Devices B Boards % Examples B Console & Pack Properties ~— O

+ —|(c®{‘I Bea| @ ¥

Pack Action Description

Search Pack

Figure 29. Refresh Pack after installation

6. Inthe Devices tab, expand All Devices > ONSemiconductor > RSL10 Series, and select RSL10 from the list.
The RSL10 CMSIS-Pack now appears in the list of installed packs in the Packs tab. Expanding
ONSemiconductor.RSL10 makes the Pack Properties tab display the details of the RSL10 CMSIS-Pack.
Figure 30 on page 27 illustrates what the Pack Manager perspective looks like after installation.

@ IAR Embedded Workbench CMSIS Manager [ e
File Edit Search CMSIS Manager Window Help
@Qis~ o h 2w > Quick Access :| [ \@
~ B #Packs 2 M Devices B Boards = Pack Properties % Examples & Console TE ¢ @m|@ =0
Search Pack
Pack Action Description
4 ® Device Specific 1 Pack RSL10 selected
4 % ONSemiconductorRSL10 ¥ Up tg daty ON Semiconductor RSL10 Device Family Pack
B 24450 [® Remove = www.onsemicom
* Generic Software Packs with generic content not specific to a devi...

Figure 30. The IAR Embedded Workbench CMSIS Manager after RSL10 CMSIS-Pack is Installed

5.3 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE IAR EMBEDDED WORKBENCH

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIOG6) blink on the Evaluation and Development Board. The procedure described in this
section assumes that you have installed the SDK.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.

5.3.1 Import the Sample Code

Import the sample code to your workspace as follows:

1. Inthe IDE’s CMSIS Manager, click on the Examples tab to list all the example projects included in the
RSL10 CMSIS-Pack.
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2. Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 31 on page 28). Choose a destination folder for a copy of the sample code.

@8 Packs M Devices B Boards [ Examples 2 & Console

Search Example

Example Action
ADC_UART (RSL10 Evaluation Board)
ble_central_client_bond (RSL10 Evaluaiiar\‘ Copy.

ble_central_client_scan (RSL10 Evaluation \’ Copy
ble_peripheral_server_bond (RSL10 Evalua\_’ Copy

ble_peripheral_server_hrp (RSL10 Evaluatiw\. Copy

blinky (RSL10 Evaluation Board) \_’ Copy
default MANU_INFO_INIT (RSL10 Evaluati([$ Copy.
hci_app (RSL10 Evaluation Board)

i2c_cmsis_driver (RSL10 Evaluation Board)$ Copy
kernel_timer (RSL10 Evaluation Board)

peripheral_server_sleep (RSL10 Evaluaticn\. Copy

peripheral_server_standby (RSL10 Evaluati\’ Copy
spi_cmsis_driver (RSL10 Evaluation Bcard)\_’ Copy
supplemental_calibrate (RSL10 Evaluaticn\’ Copy

uart_cmsis_driver (RSL10 Evaluation Boarc\_‘ Copy

\_0 Copy

\’ Copy

\’ Copy
measure_rc_osc (RSL10 Evaluation Board)\_‘ Copy

Description

ADC with UART Sample Code

BLE Central Client Bonding Sample Code
Central Device with Client Scanner Sample Code

. BLE Peripheral Server Bonding Sample Code

Heart Rate Peripheral Device with Server Sample Code

. Blinky GPIO I/O Sample Code

Default System Initialization Function
Host Controller Interface Application

. 12C CMSIS-Driver Sample Code

Kernel Timer Sample Code

. Measure 32 kHz RC Oscillator
Sleep Mode Sample Code for Peripheral Device with Serv...
Peripheral Device with Server and Standby Power Mode S...
| SPLCMSIS-Driver Sample Code

Default System Initialization Function

. UART CMSIS-Driver Sample Code

O Only show examples from installed packs | S~ m\ @® v =0

Figure 31. IAR Embedded Workbench CMSIS Manager: Examples Tab

Sample projects are preconfigured with release versions of RSL10 libraries, which are distributed as object files.
For the IDE, System library (libsyslib) and Startup (libcmsis) are preconfigured with the source variant, so the source
code of those libraries is included directly in both CMSIS Manager and IAR Embedded Workbench IDE windows
(see Figure 32 on page 28 and Figure 33 on page 29).

@ by linky econfic - IAR Embedded Warkbench CMSIS Manager = e
File Eca Scwce Rafsctor Mavigate Sestch Project CMSISManager Fun Window Melp
o I B N T RN P S B v | af@
= % biliniy rtecontig = ou
& Components - ¥
An outire 15 not available.
Software Components el Variant Vendor Version  Deseription
M siip ARM Cortes:M3 48 Mz, 24 B RAM, 354 kfl ROM
ot + ® Device

# Bluetooth Profile:
 * Librries

- s RELL0
& r3ll0_protocole |OF
& r3110_romwect.c

telease L ONSemiconduc 24450
& ral10_sys_swee
4 rsl10. 55 sedio.
& 1810 _sys clockac
& rsl10.5y5.crec

¥
& 14110_sy3_power_ modesc
& 13110, sy5_powerc
D_syseflec
0,5y timeesc

Validdation Qutput Dessription
system_raloic
RTE Componentsh
&= sattings
appe
by ewel Components| Device Packs
P £ Probiems
iy, ewt -
# by teconfig 9 iboms .
readme_biinky b Description Resource: Path Locatian Type

sectionic!

Figure 32. RTE Configuration for the Blinky Example Project in the IAR Embedded Workbench CMSIS Manager
window
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File Edit View Project J-Link Tools Window Help

Debug B
Files - B
=f Jblinky-Debug [ v [ |

F& m CSIS-Pack
— R RTE_Components.h
2 0 Device. Startup source
| & startup_rsl10.s
| ayatarmn_rsl10.c
lagm Dewvice.Libraries System source
rsI10_protocol.c
rsl10_rarvect.c
rsl0_sys_asrc.c
rsl0_sys_audio.c
rsl0_sys_clocks.c
[ rs0_sys_cre.c
rsl10_sys_dma.c
rsl0_sys_flash.c
rsI10_sys_power.c
rsl10_sys_power_modes.c
rs0_sys_tfe.c
rsl0_sys_timers.c
rs0_sys_uarc
[ rsN0_sys_wversion.c
M include
app.c
— B readme_hlinky: b
B Cutput

b

T

Figure 33. RTE Configuration for the Blinky Example Project in the IAR Embedded Workbench window

5.3.2 Building the Sample Code

To build the sample code:

1. Right click on the folder for blinky and choose Rebuild All. Alternatively, you can use the icon shown in
Figure 34.

File Edit View Project J-Link Tools Window Help

Workspace

Debug -
Files &G
S blinky - Debug EX

Figure 34. Starting to Build a Project in the IAR Embedded Workbench
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2. When the build is running, the output of the build is displayed in the Build Output view in the IDE, as
illustrated in Figure 35.

Build Files

E @ blinky - Debug
Messages M include

Building canfiguration: blinky - Debug Bappc

Updating build tree... F— B readme_blinky.bt
starup_rsl10.s W CMSIS-Pack

Lok -

rsl10_sys_flash.c
rsl10_sys_power.c
rsl10_sys_rife.c
rsl10_sys_power_rodes.c
rsl10_sys_fimers.c
rsl0_sys_uartc
rsl10_sys_wersion.c
systern_rsl10.c
Linking

flinky.out
Convering

Tatal nurnber of errors: 0
Total nurmber of warnings: 0

Build | Debug Log

110_protacol L i Output

e emonete — B blinky.map

rsl10_rarmect.c P .

rsl0_sys_asrc.c linky.ou

app.c - Outp_ut

rsl10_sys_audio.c t: O bl!nky.hex
B blinky.map

rsl0_sys_clocks.c | Coope

rsl0_sys_croc 0 d\p?'id na

rsl10_sys_dma.c 0 m?MZtI .

— [ rs10_protocol.o
F— O rsN0_ramvecta
— [Clrsl10_sys_astco
— [ rsl0_sys_sudio.o
— [1rs10_sys_clocks.o
F— [ rs0_sys_crco
F— O rsl0_sys_dma.o
F— D rsl0_sys_flash.o
F— [ rsl0_sys_power.o
F— [ rsl10_sys_power_modes.o
F— O rs0_sys_rife.o
F— Dlrsl0_sys_timers.o
F— D rsl0_sys_uarto
F— D rsl10_sys_version.o
F— DM _tla

— B sections.icf

— Dshbla

— O startup_rell 0.0

L— [ system_rsl10.a

Figure 35. Example of Build Output

3. The key resulting output shown in Project Explorer in the IDE includes:

*  blinky.hex: HEX file for loading into flash memory
*  blinky.out: Arm executable file, used for debugging

*  blinky.map: map file of the sections and memory usage

5.3.3 Debugging the Sample Code

5.3.3.1 Debugging Applications

IDE debug configurations are already set in the CMSIS pack. To debug an application:

1. Make sure the Evaluation and Development Board is connected to the PC via a micro USB cable.
2. Select Project > Download and Debug, or click the icon shown in Figure 36, then accept the J-Link pop-up
dialog in order to use the flash breakpoints (as shown in Figure 37).

File Edit View Project J-Link Tools Window Help
DOE@ = X3 SC r<Q>%=2< B >0 AO-= roCidhs

¥

Figure 36. Start/Stop Debug Session Icon
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m J-Link V6.34h Out of breakpoints 28

The debugger is trying to set a breakpoint in flash mermory st address 0x001003E8
l The target CPU has run out of hardware breakpoints.

In order to setthe requested breakpoint, a software breakpoint in flash memory can be set.

Unlirnited breakpoints in flash memary (Flash Breakpoints) is an enhanced feature of JLink which requires an additional license.

Some members of the J-Link family (such as J-Link PRO and J-Link PLLUS) already come with a built-in license for unlimited breakpoints in flash memory.
In ordet to buy a license far unlimited breakpaints in flash memaory for the connected emulatar, please getin touch with sales@segger.com.
Formare infarmation regarding this feature, please refer to hitp:/ favew segger.com/fjlink_buy_flashbps html.

Howewer, using this feature without the additional license is possible and permitted if used for evaluation only.
Evaluate unlimited breakpoints in flash rmemony now ?

J-Link 5/M; 483035975

L) Do not show this rmessane aoain fi

[ ves \ ‘ (s} ‘ ‘ Install existing license...

Figure 37. J-link “Out of breakpoints” pop-up dialog

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 7.4.1, “Downloading Firmware in Sleep Mode” on page 45.

3. The application runs up to the first breakpoint in main. You can press F5 or the Run icon (as shown in
Figure 38) multiple times to step through the code and observe that the LED changes its state when the

application executes the function Sys_GPIO Toggle (LED _DIO). To stop the debug session, press the Stop
icon.
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@ work - IAR Embedded Workbench IDE - Arm 8.32.1
File Edit View Project Debug Disassembly J-Link Tools Window Help

(o male X R c 2 4Q>5r2< B0 B0=8c@7in e i ()08 Dima 8T
‘Workspace v X ‘ app.c X ‘ v/ Disassembly
Debug v | mainf) ‘CQ Goto
105 + Assumptions : None A ||
Files LR ) 106 . - | Disassembly
2 @ blinky - Debug “ 107  int main(void) {
1 B CMSI5-Pack 108 F { main:
|— R RTE_Compaonents h /*Initislize global variables */ 0x1003e8: O0xh510 PUSH
9 ; led_toggle status = 1; T
m Device, Startup sou... L T ! led_toggle_status = 1:
L3 m Device Libraries S L P— S 0x1003ea: Ozdeld LDR.W
rel10_protoeol.c £ ;m;f;ﬁ:;]f the system +/ 0x1003ec: 0x2001 MOVE
rsl10_rarmvectc & O0x1003ee: 0=7020 STRB

Initialize():
O0x1003£0: Oxf7ff Oxffd2 BL
Bys Watchdog Refresh():

[ rs0_sys_asrc.c
rsI10_sys_audio
[ rs0_sys_clock.

/* Spin locp *+/
wnile {1)
{

rsl10_sys_crec £ /* Refrssh the vatchdog timer =/ Ox1003f4: Oxf7ff Ozffb5 BL
rslT0_sys_dmac Sys Watchdog Refresh(): if (led toggle status == 1)
rs110_sys_flash.c - N Ox1003f8: 0=7820 LDRE
rs10_sys_pows /* Toggle GPIO 6 (if toggling is enabled) then wait 0.5 seconds =/ 0x1003fa: 02801 CHMP

FE [ rsl10_sys_powe.. if (led_toggle_status 0x1003fc: 0xd003 BEQ.W
rsl10_sys_rffe.c { Sys_GPIO_Set_Low(LED_DIO):
B rsl10_sys_timet... 5ya_GPIO Toggle(LED DIO)G Ox1003fe: 0x2006 MOVS

HE Ers0_sys_uartc } 0x100400: Oxf7ff Ox££95 BL
rsl10_sys_versi. else Ox100404: 0Oze002 B.N

-2 &include l - 10_Toggle (LED_DIO
L Rapph Sys GPIO_Set_Low(LED DIO); @ - o
: 0x100406: O0x£7ff Oxff9% BL

2 D app.c

|— B readme_blinky b4 Sys_Delay ProgramROM((uint32 t) (0.5

Sys_ Delay ProgramROM( (uint32_t

+ SystemCorsClock)); E

—!?-’C_J‘utpu\ . | Ox10040c: 0x4B817 LDR.N
S = — 0x10040e: D0x6800 LDR W
I hlinky silie 11 k)| 1 | r
Debug Log v o X
Log e
Fribdany 17, 2019 13:29:42: ROMTBI[0][2]: E0DD2000, CID: B105E00D, PID: 00288003 FRE
FriMay 17, 2019 13:29:42; Executing RSL10 reset type: 0x00000002
Fri May 17, 2018 13:28:42: Unsupported RSL10 Reset Type: 0x00000002
Fri May 17, 2019 13:29:42: Hardware resetwith strateqy 2 was performed
Fribdany 17, 2019 13:29:42: Initial reset was pedormed
Fri May 17, 2019 13:23:43: J-Link: Flash download: Bank 0 @ 0x00100000: 1 range affected (2048 bytes)
Fri Many 17. 2019 13:29:43: J-Link: Flash download: Total time needed: 0.214s (Prepare: 0.085s. Compare: 0.022s. Erase: 0.024s, Program: 0.045s. Verify: 0.028s. Restore: 0.007s) -
FriMay 17, 2019 13:29:43: 1860 bytes downloaded and verified (4.01 Khytes/sec)
Fribday 17, 2019 13:29.43: Loaded debugee: C:\MNew folder\blinky\ Delug!, Exelblinky.out =
FriMay 17, 2018 13:28:43: Executing RSL10 reset type: 0x00000001 T
Fri May 17, 2019 13:29:43: Software resetwas performed |
FriMay 17, 2018 13:29:43: Target reset =
Ebin 17 AA1A42.00.00 D21 Lt P e P e A DAY e b e
il T | )
Build | Debug Log
Ready Ln 124, Col 13 System CAP NUM OVR E=

Figure 38. Debug Session in the IAR Embedded Workbench
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CHAPTER 6

Resolving External CMSIS-Pack Dependencies

1. EXTERNAL CMSIS-PACK DEPENDENCIES

Some of the RSL.10 sample applications depend on software components from external vendors. For example,

applications that make use of CMSIS-Drivers or FreeRTOS depend on CMSIS-Packs provided by Arm®. The
dependencies are displayed in the RTE Configuration (see Figure 39 for an example).

2. RESOLVING EXTERNAL DEPENDENCIES

The following instructions show how to easily identify and resolve external dependencies in RSL10 sample
applications using the CMSIS-Pack manager.

¢ Components [/

Software Components Sel. Variant Vendor Version Description
B RrsL10 ONSemiconduc ARM Cortex-M3 48 MHz, 24 KB RAM, 388 KB ROM
- CMSIS [ |
. € CMSIS Driver
» % Device
. % RTOS Bl FresrTOS ARM )
Validation Output Description
@ ARM:CMSIS.RTOS2.FreeRTOS Component is missing. Pack is not installed: ARM.CMSIS-FreeRTOS
@ ARM.FreeRTOS:RTOS.Config.CMSIS RTOS2 Compaonent is missing. Pack is not installed: ARM.CMSIS-FreeRTOS
© ARM FreeRTOS:RTOS.Core.Cortex-M Component is missing. Pack is not installed: ARM.CMSIS-FreeRTOS
@ ARM FreeRTOS:RTOS Event Groups Component is missing. Pack is not installed: ARM.CMSIS-FreeRTOS
@ ARM.FreeRTOS:RTOS. Heap.Heap_4 Compaonent is missing. Pack is not installed: ARM.CMSIS-FreeRTOS
© ARM FreeRTOS:RTOS Timers Component is missing. Pack is not installed: ARM.CMSIS-FreeRTOS

Figure 39. RTE Configuration Perspective Before Resolving Pack Dependencies

Figure 39, above, shows the RTE Configuration view when Pack dependencies are unresolved. To resolve Pack
dependencies, follow these steps:
1. In the CMSIS-Pack Manager perspective, click on the Check for Updates on Web button (see Figure 40).

mO|lfRESmF| @ Y= 0

l Check for Updates on Web ]

Figure 40. Check for Updates on Web Button

Figure 41, below, shows an example of the Packs tab after checking for updates.
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M Devices 2 Bl Boards = B @ Packs % ¥ Examples el
Bl %|® ~ | searchPack

Search Device Pack Action Description

Device Summary * || 4 *® Device Specific 8 Packs ARM selected

4 % Al Devices 6249 Devices 3 aaEARl‘v‘I.Musca_.»i\l_BSP @ Install Musca Al Board Support PACK for CoreLink SSE-200 based
> ¥ ABOV 20 Devices 3 aaG,i\RI‘v'I.Musca_Bl_BSP @ Install Musca B1 Board Support PACK for Corelink SSE-200 based
> ¥ Active-Semi 4 Devices > aﬁARM.VEM*MPSZ?SSEJDU,B!@ Install ARM V2M-MPS2 Board Support PACK for Corelink SSE-200
> ¥ Ambig Micro 8 Devices b aaGARM.V2l‘v‘I—MPSS_SSE_2DD_B:§ Install ARM V2M-MPS3 Board Support PACK for CoreLink SSE-200
> ¥ Amiccom 5 Devices - Keil V2M-MPS2_CMx_BSP @ Install ARM V2M-MPS2 Board Support PACK for Cortex-M System
> ¥ Analog Devices 14 Devices - Keill V2M-MPS2_DSx_BSP @ Install+  ARM V2ZM-MPS2 Board Support PACK for DesignStart Devic
- ¥ APEXMIC 14 Devices - Keil V2M-MPS2_IOTKit_BSP @ Install ARM V2M-MPS2 Device Family Pack for IOT-Kit devices

| > Y ARM |5? Devices - Keil V2M-MPS3_IOTKit_BSP @ Install+  ARM V2M-MPS3 Device Family Pack for IOT-Kit devices

> ¥ AutoChips 24 Devices 4 ® Generic 38 Packs Software Packs with generic content not specific to a device
> ¥ Cypress 425 Devices 3 aaEAlibahaJ!\IiOSThings @ Install AliOS Things software pack
> ¥ Dialog Semiconduct 14 Devices - %8 ARM.AMP [@ Install Software components for inter processor communication (2
» % GigaDevice 160 Devices | 4 % ARM.CMSIS [ Install  |CMSIS (Cortex Microcontraller Software Interface Standard)
> ¥ HDSC 26 Devices #551 (2019-03-20) & Unpack | The following folders are deprecated - CMSIS/Include/
> ¥ Holtek 171 Devices = > *® Previous ARM.CMSIS - Previous Pack Versions
> " Infineon 175 Devices - " ARM.CMSIS-Driver @ Install+  CMSIS Drivers for external devices
> ¥ Lapis Semiconductol 2 Devices 3 aaGARI&"I.CMSIS—Dri\fer_VaIida‘cic Install CMSIS-Driver Validation
> ¥ Maxim 16 Devices - % ARM.CMSIS-FreeRTOS Install+  Bundle of FreeRTOS for Cortex-M and Cortex-A
> ¥ Mediatek 2 Devices b aaGARM.CMSlS—RTOS_VaIidatio@ Install CMSIS-RTOS Validation
> ¥ Microchip 378 Devices - %8 ARM.mbedClient Install ARM mbed Client for Cortex-M devices
> ¥ MindMotion 89 Devices - % ARM.mbedTLS @ Install ARM mbed Cryptographic and SSL/TLS library for Cortex-M
> ¥ Nordic Semiconduct 15 Devices - " ARM.minar @ Install mbed OS Scheduler for Cortex-M devices
> ¥ Nuvoton 621 Devices - %8 ARM.TFM @ Install Trusted Firmware-M (TF-M} is the reference implementatior
> ¥ NXP 1169 Devices . birdec.bi-pcm3060 Install CMSIS-Driver for sound codec TI PCM3060
> " ONSemiconductor 1 Device > %8 EmbeddedOﬁice.FIexthe_Sa@ Install Flexible Safety RTOS

Figure 41. Installing the Arm CMSIS-Pack

2. To manually install a CMSIS-Pack, select the Packs tab and search for the required CMSIS-Pack (in this
example, we installed the ARM.CMSIS pack); click the Install button (shown in Figure 41). Alternatively,
follow the next steps to automatically resolve any Pack dependencies that are missing.

3. Open the *.rteconfig file; in the Packs tab, select the Resolve Missing Packs button (see Figure 42).

%5 Packs [ Use all latest Packs || Resolve Missing Paclsl [ Show only used Packs |

Pack Selection Version  Description

» %8 ARM.CMSIS EE:-: rackisnotinstalled

- %8 ARM.CMSIS-FreeRTOS Y 2 0534 Packis not installed

» % ONSemiconductorRSL10 atest 430534 ON Semiconductor RS5L10 Device Family Pack

Components|Device Packs

Figure 42. Resolve Missing Packs Icon

L]
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4. The IDE prompts you to read and accept the license agreement, then installs the missing Packs. Figure 43
illustrates the RTE configuration after resolving missing Packs.

5 Packs | Use all latest Packs | & Show only used Packs

Pack Selection Version  Description
s ‘%&ARM.CMSIS atest PEERE CMSIS (Cortex Microcontroller Software Interface Standard)
- % ARM.CMSIS-FreeRTOS atest 41020 Bundle of FreeRTOS for Cortex-M and Cortex-A
- % ONSemiconductorRSL10 atest 430534 ON Semiconductor RSL10 Device Family Pack

Figure 43. RTE Configuration Perspective After Resolving Pack Dependencies
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CHAPTER 7

Advanced Debugging

7.1 PRINTF DEBUG CAPABILITIES

The PRINTF () macro is used to provide printf () debug capability in RSL10 applications. The implementation
of the PRINTF () macro is user selectable to allow for different types of debug interfaces. The functionality is accessed
via the tracing API.

The tracing API supports two debug interfaces: UART and RTT. The implementation of the tracing functions can
be found in the app_trace.c file. The developer can select the debug interface during the compilation process by setting
the RSL10_DEBUG macro in the app_trace.h file. If the macro is set to DBG_NO, tracing is disabled. This is the default
behavior in all sample applications.

NOTE: The files app_trace.c and app_trace.h need to be present in your sample application, and
initialized using TRACE_INIT (), in order to for you use the PRINTF () feature. You can find
these two required files in most Bluetooth Low Energy sample applications, such as
ble_peripheral_server_bond.

To debug time critical applications, we recommend setting the tracing option to DBG_RTT option. With SEGGER
RTT (Real Time Transfer), you can output information from the target MCU to the RTT Viewer application at a very
high speed without compromising the target’s real time behavior. More information about SEGGER RTT can be found
in JLINK user manual, at www.segger.com.

7.1.1 Adding Printf Debug Capabilities

To add printf debug capabilities over UART, change the define in the app_trace.h file to #define RSL10 DEBUG
DBG_UART, and set the RSL10_DEBUG macro to DBG_UART. A standard terminal program on a PC can be used to view
the debug output.

To add RTT printf debug capabilities, change the define in the app_trace.h file to #define RSL10_ DEBUG
DBG_RTT and add the SEGGER RTT files to the application. The Segger RTT Viewer application on a PC can be used
to view the debug output.

To enable printf, add OUTPUT INTERFACE=OUTPUT UART or OUTPUT INTERFACE=RTT in the preprocessor
settings as follows depending on which IDE you are using:

*  For Eclipse, right click the sample app name and choose Properties > Tool Settings > C Compiler >
Preprocessor.

*  For Keil, in the menu bar choose Project > Options for Target > C/C++.

*  For IAR, right click the sample app name and choose Options > C/C++ Compiler > Preprocessor.

Samples for RTT are under C:\Program Files (x86)\SEGGER\JLink_V640b\Samples\RTT.

More information about the RTT API can be found in the JLINK manual, under C:\Program Files
(x86)\SEGGER\JLink_V640b\Doc\Manuals.

NOTE: Note that these RTT sample and information files are for SEGGER JLink version 640b.
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7.2 DEBUGGING APPLICATIONS THAT DO NOT START AT THE BASE ADDRESS OF FLASH

If you want to debug an application that does not start at the first address of the flash memory (0x00100000), read

on. For example, you might be debugging an application in RAM, or a flash memory application that has been placed in
a different address.

This procedure assumes you have performed the steps in Section 3.4.1, “Debugging with the .elf File” on page 14,
and you are using the onsemi IDE:

1. In your Debug configuration, change to the Startup tab
2. Enter the following in the Run/Restart Commands field as illustrated in Figure 44:

set {int} & VTOR = ISR Vector_ Table
set $sp = *((int *) &ISR Vector Table)
set $pc * ((int*) (&ISR Vector Table+4))

Create, manage, and run configurations '@

FoEX OV~ Name: [ blinky |

[5) Msin |35 Debugger | i Startup | &, Source| ] Common| ., SVD Path
[E] C/C++ Application Initialization Commands
[£] C/C+ Attach to Application Initial Reset and Halt Type: | | Low speed: [ 1000 | kHz
C/C++ Container Launcher
[E] C/Co+ Postmortem Debugg || JTAG/SWD Speed: ® Auto O Adaptive O Fixed kHz
[E] C/C++ Remote Application Enable flash breakpoints

Cij C/C+ Unit Ensble semihosting Console routed to: [7] Telnet [] GDE client
GDE Hardware Debugging

5 GDB Open0CD Debugging [FEnzble SWO  CPU freg: Hz SWOfreq: [0 | Ha Portmask:
|| v [E] GDB SEGGER J-Link Debuggit
| blinky

5 Launch Group

Load Symbols and Executable

[ Load symbols

@®) Use projiect binary:  blinky.eff
O Use file:

Workspace.. | File System..
Symbolsoffset hexk | |

[ Load executable

® Use project binary:  blinky.eff

O Use file: Workspace.. | File System..

Executsbleoffset (e[ |

Runtime Options
[ RAM application (reload after each reset/restart)

Run/Restart Commands

Pre-run/Restart reset Tpe| | (aweys cxecuted at Restart)

set {int} &_VTOR = ISR _Vector_Table
set $sp = *({int *) &ISR_Vector_Table)
set $pc = *((int") (8USR_Vector_Table+4))

[1Set program counter at (hex):

et et
[ Continue
1 Restore defaults
< >
Revert Apph
|| Fiter matched 11 of 11 items = 6]
@

Figure 44. Setting Up a GDB Launch Configuration, Startup Tab
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7.3 Arm Cortex-M3 Core Breakpoints

A maximum of two hardware breakpoints can be set at a given time. If you need more than two breakpoints, you
can use the Unlimited Flash Breakpoints feature available through J-Link.

IMPORTANT: You can use hardware breakpoints when using the debugger with the Arm Cortex-M3 core, but
software breakpoints cannot be used with the flash overlay. Writing to flash memory does not place breakpoints
within the overlay, so any attempt to use software breakpoints would be ineffective.

7.4 DEBUGGING WITH Low POWER SLEEP MODE

Debugging applications that use sleep mode is a challenging task because the hardware debug logic and system
clocks are powered down when the device goes to sleep. Therefore, the debug session cannot be kept alive between
sleep cycles.

Besides using GP10s, UART, and other peripherals as tools to help debug your application, you can reattach the
debugger after the device wakes up from sleep. To do so, you need to make sure that the device stays awake, and start a
new debug session to connect to the running target, making sure a reset is not performed. The following instructions
show an example of how to perform this on the peripheral_server_sleep sample application in the onsemi IDE, but you
can also adapt it for other applications that use sleep mode, and for other IDEs.

1. Copy the peripheral_server_sleep application into your workspace and navigate to the app_process.c source
file under the code folder.

2. Modify the function void Continue Application (void) by adding a while loop before the
Main Loop () ; call, to make sure that the device stays awake in the infinite loop after waking up (see
Figure 45). Save and compile your application.
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=
N |45 || B 45 Debug || [E] blinky Debug - Br%r@BDin -G -0 -~ ™S ] § 0= Hler -
(3 Projeet Exploses 7] = [0 52 Outies
A U spph
v 5 periphers]_serves_sh o tenligure k dlviders = ® " lcap_ent
S peaphenl seve sdeep CLE-300V_CFGR = SLOWCLK_PRESCALE_VALUE | BUCLYK_PRESCALE_VALUE | MAY GUE CHT
&l Inchudes - Seiw Bneeiale T - - # M BUFCN
USACLK_PRESCALE 1; -
v 2 eode CLK_DIV_CFG3->DCCLE_BVTE = DECLE_BVTE_VALUE; ®  messure buf
® bufcm
date Flash timing ® ° TAN DESC_APP
2 bhe bass.c FLASH=2DELAY_CTRL = DEFAULT_READ_MARGIN | FLASH_DELAY_VALUE; 8% appm _defsult_siste
£ bile_gustam.s . . . ®© appen_default_handler
4 blestdc €LK_SYS_CFG->SYSCLE_SRC_SEL_BYTE = SYSCLK_CLESRC_RFCLK_DYTE; ®  wppmLstate: bestate
£ calibration B Sieep Mode Confiqureistnact seep_made_eny_tag’)
(5 wakeup_ssm.5 . n o Wakeup From Shee %)
enchudt due early ACS wake-up Jiticn (&.g. PAD, K "
& imchud BBIF-»CTRL = BE_CLK LE | BECLK_DIVIDER_VALUE | BS_MWAKEUR;
. FTE .
£ appc ask all interrup *
4 periphens server sleep necenfi disable_irg); .
=) readme_penphesal_serer_teep.md while {1{BLE_Is_fwake())) & Mag Handler(const ke_meg_id t, veid®, const ke_task id 1, conat ke task_id t) - int
i »  AUDIOUMKE PERIOD IRCHandler{veid)

$Y5_WALT_FOR_INTERRUPT

__enable_irq();
disable_irq():
'r
if (RTC_CLE_SRC != ATC_CLK_SRC_XTALIN)

i
1 BLF [LOW_POMER_CLK_UPDATE == LOW_POWER_CLK_UPOATE_ENABLE)
Fnable_fudiosink_Measurement{);
4 mendif

BRIF->CTAL = BR_CLK_FMABLE | BRCLK_DIVIDER VALUF | BE_DEER_SLEEP;

While (1]
i

Sys_Watchdog_Refreshi):
'r

Main_Loop();

Figure 45. Continue_Application Function Perspective After Adding While Loop

3. Within the Project Explorer, right-click on the .elf file and select Debug As > Debug Configurations.
4. When the Debug Configurations dialog appears, create two debug sessions:
a. Debug session that initiates restart and halts the target:
i.  Right-click on GDB SEGGER J-Link Debugging and select New. A new configuration appears
under the GDB SEGGER heading, with new configuration details in the right panel.
ii.  Adjust the displayed values for your configuration and click on Apply (see Figure 46, and Figure 47
on page 41).

NOTE: If you are having trouble downloading firmware to the device, in addition to using DIO12, you
can also perform the software recovery by setting the Reset Type to 1 in the Debug session
configuration (see Figure 46). The default Reset Type is 0, which only resets the Arm
Cortex-M3 core while leaving the device/peripherals in a state where J-Link can't reconnect.
Setting the Reset Type to 1 ensures that not only is the Arm Cortex-M3 core reset, but so are all
the peripherals. If this does not work, see Section 7.4.1, “Downloading Firmware in Sleep
Mode” on page 45.
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& Debug Configurations

Create, and run tions

&

EIEE R

[ E

Name: peripheral_server_sleep Debug

type filter text Main | %5 Debugger | Startup . - Sourcew i=] Common] % SVD Path]

5] C/C++ Application Initialization Commands
[E] C/C++ Attach to Application

v|Initial Reset and Halt[Type: 1| L d: 1000 KkH
[€] C/C++ Postmortem Debugger Hasseancta Hrvpe: ow spee z
[2] C/C++ Remote Application JTAG/SWD Speed: @ Auto () Adaptive () Fixed kHz

< Eclipse Application

[2] GDB Hardware Debugging

[€] GDB OpenOCD Debugging

[c] GDB SEGGER J-Link Debugging
[€] peripheral_server_sleep Debug
[€] peripheral_server_sleep_swd_att

Java Applet

Java Application

Enable flash breakpoints
Enable semihosting Console routed to: [v| Telnet ] GDB client

Enable SWO CPU freq: 0 Hz. SWO freq: 0

.

Load Symbols and Executable

Ju JUnit Load symbols
36 JUnit Plug-in Test

(@) Use project binary: peripheral_server sleep.elf
@ Launch Group

(@) Use file:

Hz. Port mask:  Ox1

n

Worksy File System...
B Launch Group (Deprecated) Workspace € system
[¥ Mwe2 Launch Symbols offset (hex):
4 OSGi Framework e adlexeetiable
Z Remote Java Application (@) Use project binary: peripheral_server sleep.elf
(@) Use file: Workspace... File System...
Executable offset (hex): i
Filter matched 19 of 100 items [ Rewen [ Aoy |
® | Debug | l Close I

Figure 46. Setting Reset Type in the Debug Configuration Session
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£ Debug Configurations

Create, manage, and run configurations

CHeEX B -~

Name: | peripheral_server_sleep Debug |

type filter text

[2) Main | %% Debugger | = Startup ._E» Source| [£] Common| 2, SVD Path
[E] C/C++ Application

Initialization Commands A
o e || [ imit e s [0
[E] C/C++ Postmortem Debugger ITAG/SWD Speed: ® Auto () Adaptive O Fixed KkHz
[£] C/C++ Remote Application nable flash breskpoints
Cif C/C++ Unit nable semihosting Console routed to: [ Telnet [ GDB client
% EES g;g"g;%ﬁ”ﬂrﬂi nable SWO CPUfreq: [0 | Hz SWOfreq [0 Hz. Port mask: [ 0«1

+ [] GDB SEGGER J-Link Debugging
[2] peripheral_server_sleep Debug
L Launch Group
B Launch Group (Deprecated)

Load Symbols and Executable

[] Load symbols

(® Use project binary: peripheral_server_sleep.elf

O Usefile: Workspace... | File System...
Symbols offset(hey | |
[] Load executable,
®) Use project binary:  peripheral server sleep.elf
O Usefile: Workspace... | File System...
Becstableoffset hot [ |
Runtime Opticns
[ RAM application (reload after each reset/restart]]
Run/Restart Commands
(] Pre-run/Restart reset| Type:
[ Set program counter at (hex):
[ Set breakpoint at: main
[+] Continue -
Revert Appl:
Filter matched 12 of 49 items == BEY)

Figure 47. Startup Tab: Debug Session that Initiates Restart

b. Debug session that connects to the running target:

i.  Create another new debug configuration under the GDB SEGGER heading, with new configuration
details in the right panel.

ii.  Adjust the displayed values for your configuration then click on Apply (see Figure 48, and Figure 49
on page 43).
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]
Create, ge, and run ig
0O ® @ ® | B 3~ Mame: | peripheral_server_sleep Debug_swd_att
type filter text Main |45 Debugger . Startup| & Source| [£] Common| ‘2, SVD Path|
[€] C/C++ Application J-Link GDB Server Setup
[£] C/C++ Attach to Application Start the J-Link GDB server locally
[E] C/C++ Container Launcher . -
T C/Ce+ Postmertem Debugger Executable path: | Sfjlink_path}/Sjlink_gdbserver} Browse...| | Variables...
c@ C/C++ Remote Application Actual executable: \ C:/Program Files (x86)/SEGGER/ILink//)LinkGDBServerCL.exe
i C/C++ Unit
EIE Ggg::ard"m',m bebugaing to change it use the global or workspace preferences pages or the project properties page)
[©] GDB OpenOCD Debugging Device name: ‘ RSL10 | Supported device names
+ [©] GDB SEGGER J-Link Debugging Endianness: @ Little O Big
E peripheral_server sleep Debug Ceonnection: @ USB Qlr I:l (USB serial or IP name/address)
[©] peripheral_server_sleep Debug (1)
& Launch Group Interface: ®swD O ITAG
= Launch Group (Deprecated) Initial speed: O Auto () Adaptive (@) Fixed kHz
GDB port:
SWO port: [ Verify downloads | Initialize registers on start
Telnet port: Local host only  [] Silent
Log file: [ Browse...
QOther options: ‘ -singlerun -strict -timeout 0 -nogui
Allocate censole for the GDB server [~ Allocate console for semihosting and SWO
GDB Client Setup
Executable name: ‘ S{cross_prefixlgdbS{cross_suffix} Browse... | Variables...
Actual executable: ‘ arm-none-eabi-gdb |
Other options: | |
Commands: set mem inaccessible-by-default off
Remote Target
Host name or IP address:  localhost
Port number: 2331
[ Force thread list update on suspend
Revert Appl
Filter matched 13 of 50 items = EEY
® Cloe

Figure 48. Debugger Tab: Debug Session that Connects to the Running Target
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2 Debug Configurations o X
Create, manage, and run configurations
CEeEX B~ Name: | peripheral_server_sleep Debug_swd_att
type filter text Main [ %5 Debugger = Startup . Source| [] Common| Z, SVD Path|
[T] C/C++ Application Initialization Commands
[E] ¢/Cx+ Attach to Application [ Initial Reset and Halt_Type: Lowspeed: 1000 | kHz
[E] C/C++ Container Launcher
[E] C/C++ Postmortem Debugger JTAG/SWD Speed: @ Auto O Adaptive () Fixed KkHz
[T] C/C++ Remote Application nable flash breakpoints
Gl €/Cre Unit nable semihosting Console routed to: - Telnet | GDB client
[£] GDE Hardware Debugging Hleswo - - -
= 6D OpenOCD Debugging nable CPUfreq: 0 Hz. SWO freq: | 0 He. Portmask: Ol
~ [£] GDB SEGGER J-Link Debugging
peripheral_server_sleep Debug
peripheral_server_sleep Debug (1)
& Lsunch Group
B Launch Group (Deprecated) Load Symbols and Exccutable
Load symbols
@®) Use project binary:  peripheral_server_sleep.cif
O Usefile: Workspace... | File System..
Symbolsoffset (hex | |
[ Load sxecutable
Use project binary:  peripheral_server_sleep.clf
Usefile: Workspace. File System..

Brecutable offset thexdi

Runtime Options
ID RAM application (reload after each rESEﬂrEstarl]I

Run/Restart Commands

[] Pre-run/Restart reset Type:

(alwrays executed at Restart)

[ pet program counter at (hex):
[ et breakpoint at: main
[ [ontinue

Restore defaults

Revert Appl:
Filter matched 14 of 44 items eve pply
@

Figure 49. Startup Tab: Debug Session that Connects to the Running Target

5. Start the first debug session (which initiates target restart). Once the target is halted at main, resume the
execution (see Figure 50).
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& on-semiconductor-workspace - peripheral_server sleep/app.c - C

File Edit Source Refactor Mavigate Search Project Run  Window Help

% Debug [] peripheral_server_sleep Debug

v Ale®¥a v oy

%5 Debug &2 | [f Project Explarer | = ¥ = 8
w [£] peripheral_server_sleep Debug [GDB SEGGER J-Link Debugging] 9
w oy peripheral_server_sleep.elf 8 * app.c
v o Thread #1 57005 (Suspended : Breakpoint) i = - Main application file
= main() at app.c:21 0x1030f4 13 * $Revision: 1.73 %

s JLinkGDBEServerCL.exe
sl arm-nene-eabi-gdb
s Semihosting and SWV

14 * fDate: 2018/18/89 15:83:34 §

7 #include “app.h”
= int main()

App_Initialize();

Figure 50. First Debug Session Perspective Before Starting Execution

6. Wait until the target enters Deep Sleep Mode. At this point the debug connection is lost; and even when the
target is awake, it cannot establish a connection with JTAG. The following output is generated on the console
(see Figure 51).

& Console &2 Tasks Problems Executables B Debugger Console Memo Search
peripheral_server sleep Debug [GDB SEGGER J-Link Debugging] JLinkGDBServerCL.exe
ERROR: Can not read register 2 (R2) while CPU is running

ERROR: Can not read register 3 (R3) while CPU is running

ERROR: Can not read register 4 (R4) while CPU is running

ERROR: Can not read register 5 (R5) while CPU is running

ERROR: Can not read register 6 (R6) while CPU is running

ERROR: Can not read register 7 (R7) while CPU is running

ERROR: Can not read register 8 (R8) while CPU is running

ERROR: Can not read register 9 (R9) while CPU is running

ERROR: Can not read register 10 (R10@) while CPU is running
ERROR: Can not read register 11 (R11) while CPU is running
ERROR: Can not read register 12 (R12) while CPU is running
ERROR: Can not read register 13 (R13) while CPU is running
ERROR: Can not read register 14 (R14) while CPU is running
ERROR: Can not read register 15 (R15) while CPU is running
ERROR: Can not read register 16 (XPSR) while CPU is running
ERROR: Can not read register 17 (MSP) while CPU is running
ERROR: Can not read register 18 (PSP) while CPU is running
ERROR: Can not read register 24 (PRIMASK) while CPU is running
ERROR: Can not read register 25 (BASEPRI) while CPU is running
ERROR: Can not read register 26 (FAULTMASK) while CPU is running
ERROR: Can not read register 27 (CONTROL) while CPU is running
WARNING: Failed to read memory @ address @xDEADBEEE

Starting target CPU...

ERROR: CPU is not halted

ERROR: Can not read register 15 (R15) while CPU is running
Reading all registers

4

Figure 51. Debug Session Perspective when Debug Connection is Lost

7. Stop the debug session and click on the Terminate icon to remove all terminated targets (see Figure 52).
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)5 i
o < | — == = 1 3
& Console 2 Tasks Problems Exe e Debugge e e
O] | B
peripheral_server_sleep Debug [.GDB SEGGER J-Link Det.nugging] _IL.inkGDBSz?r\.ferCL.exe ’Term.’nate ]
ERROR: Can not read register 15 (R15) while CPU is running

Figure 52. Terminate Targets Icon

8. After the target exits Deep Sleep Mode, it is running in the infinite loop (step 1), and you can connect to the

running target by starting the second debug session (see Figure 53). Note that the debugger is able to reattach
to the running target and halt the processor after waking up from sleep.

B er-semiconductorwirkspacs - perpheral_ierver_sheep/codelipp grotesss - ON Semicomductor IDE

fie Lat Source Belicior Mavigaie Seamch Progect Run Windew Help

% || % || B || fFDebug [2] paviphesl_sarves_sleep Debug,owe ~ - -0

Froject bapiarer W =e % app_processc |

Debug, swd_stt [GDR SEGGER J-Link Debugging]

Peripherals 1

A Penphersd Addens Deserpban
IF (RTC_CLE_SHE 1e RTC_CLK_SRE_XTALEIC)

42 #AF {LOW_POWER_CLK_ UFDATE == LOW_POMER _CLEK_UPDATE_EWABLE)
" Enable_sudiosink Messuremesti};
keup_Frem_Sees_Apelication(] at app_peocess 281 u000008a Bendif

BBIF-ICTRL » BB_CLK_EMASLE | SSCLK_OIVIDER_VALUE | BE_DEEP_SLEER;

while (1}

Figure 53. Second Debug Session Perspective After Connecting to the Running Target

7.4.1 Downloading Firmware in Sleep Mode

If an application with Sleep Mode is currently on your board, and changing the Reset Type to 1 as described in
Section 7.4, “Debugging with Low Power Sleep Mode” is not working, try the following:

1. Connect DIO12 to ground.

Press the RESET button (this restarts the application, which pauses at the start of its initialization routine).

Repeat step 2 above. After successfully downloading blinky to flash memory, disconnect DIO12 from ground,
and press the RESET button so that the application works properly.

Alternatively, use the Stand-Alone Flash Loader (available with its own manual in the RSL10_Utility_Apps.zip file)
to erase the application with Sleep Mode from the board’s flash memory.
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CHAPTER 8

More Information

8.1 FOLDER STRUCTURE OF THE RSL10 CMSIS-PACK INSTALLATION

By default, the CMSIS-Pack contents are installed in the following location:

* Ifyou are using the Eclipse-based onsemi IDE or the Keil IDE:
%LOCALAPPDATAY%\Arm\Packs\ONSemiconductor\RSL10\<version>)

* Ifyou are using the |

AR IDE:

C:\Users\cuser name>\IAR-CMSIS-Packs\ONSemiconductor\RSL10\<version>

Subfolders and files are described in Table 1 and Table 2.

Table 1. Installed Folders an

d Files - CMSIS-Pack

Folder Contents

configuration J-Link flash loader files.

documentation Hardware, firmware and software documentation in PDF format. Also 3rd-party
documentation from other companies besides onsemi. Available from the books tab in the
IDE.

images Contains evaluation board pictures.

include Include files for the firmware components and libraries. Projects can point to this directory
and sub-directories when including firmware header files.

lib Pre-built libraries which can be linked to by sample code or other source code. Project
linker settings must point to this directory when linking with firmware libraries.

source firmware The source of the provided support libraries.
samples/rsix (for onsemi IDE) Sample code sources as ready-to-build
samples/uv (for Keil IDE) projects.
samplesf/iar (for IAR IDE)

svd Contains the System View Description file used in the registers view during debugging.

ONSemiconductor.RSL10.pdsc

A file that describes the dependencies to devices, processor, toolchains and other software
components for the RSL10 CMSIS-Pack.

PACK_REVISION

Identifies the revision of the RSL10 CMSIS-Pack.

Software_Use_Agreement.rtf

onsemi license agreement.

Table 2. Installed Folders an

d Files - onsemi IDE

Folder Contents

arm_tools The Arm Toolchain is installed here.

eclipse Pre-built libraries which can be linked to by sample code or other source code. Project linker settings
must point to this directory when linking with firmware libraries.

jre* The included JAVA runtime environment.

ide.exe Executable that opens the onsemi IDE.

REVISION Identifies the revision of the onsemi IDE.

Software_Use_Agreement.rtf

onsemi license agreement.

ThirdPartyLicenses.txt

License agreements with third party software included in the IDE.
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8.2 DOCUMENTATION

8.2.1 Documentation Included with the CMSIS-Pack

A set of documents is included with the CMSIS-Pack installation in
C:\Users\<cuser id>\AppData\Local\Arm\Packs\ONSemiconductor\RSL10\<version>\documentation (where
<user_id is your profile name, and <versions> is the version number, e.g., 3.0.521).

These documents are also accessible via any of the three IDEs:

« onsemi IDE: documentation is accessible through the C/C++ perspective by opening any RTE configuration
file, such as blinky.rteconfig, and selecting the tab Device (see Figure 54, below).

*  Keil pVision IDE: documentation is available in the Books tab, as shown in Figure 55.

* TAR Embedded Workbench: documentation is accessible through the IAR Embedded Workbench CMSIS
Manager window, as shown in Figure 56 on page 49.

& on-semiconductor-workspace - blinky/blinky.rteconfig - ON Se ctor IDE
File Edit Source Refactor Navigate Search Project Run Window Help
- Debug [£] binky Debug Hr L B R B DN S G ErF A0 R @S
[ Project Explorer 52 ES|® ¥ = 8 4 blinkyreconfig 5 =8
viE blinky ‘M Device @
35, Binaries
) Includes Device  RSL10 Change...
(= Debug
= include Family:  RSL1D Series cPu; ARM Cortex-M3
& RTE SubFamily: Max. Clock: 48 MHz
18 app.c Vendor:  ONSemiconductor Memory: 24 KB RAM, 388 KB ROM
Pack: ONSemiconductorRSL10.3.1.590 FPU; none
[w] readme_blinky.md URL: hittp:/fwww keil.com/ dd?/onsemiconductor/rsl10 Endian: Little-endian
Device data books: Description:
@ ARM and Thumb-2 Instruction Set Quick Reference Card RSL10is an ultra-low-power, multi-protocol 2.4 GHz radio
esigned for use in wireless devices that demand low power
R Gap Interface Specification designed f less devices that demand low p

ti d stricted 3
@ GATT Interface Specification SR B

®12C Interface Specification

@ R5L10 Bootloader Guide

®:RSL10 Firmware Over-The-Air User's Guide

@ R5L10 Firmware Reference

@ RSL10 Getting Started Guide

®:R5L10 Hardware Reference

@ R5L10 Sample Code User's Guide

® RW BLE Alert Notification Profile Interface Specification
®:RW BLE Battery Service Interface Specification

@ RW BLE Blood Pressure Profile (BLP) Interface Specification
@ RW BLE Cycling Power Profile Interface Specification
®:RW BLE Cycling Speed and Cadence Profile Interface Specification
@ RW BLE Device Information Service Interface Specification

@ R\W BLE Find Me Profile Interface Specification

®:RW BLE Glucese Profile (GLP) Interface Specification

@ RW BLE Health Thermometer Profile Interface Specification
®:RW BLE Heart Rate Profile (HRP) Interface Specification

®:RW BLE HID Over GATT Profile Interface Specification

@ RW BLE Host Error Code Interface Specification

®:RW BLE Location and Navigation Prefile Interface Specification
®:RW BLE Phone Alert Status Profile Interface Specification Interface Specification
 RW BLE Proximity Profile Interface Specification

®:RW BLE Running Speed and Cadence Profile Interface Specification
R BLE Scan Parameters Profile Interface Specification

@ RW BLE Time Profile (TIP) Interface Specification

®:RW BLE Wireless Power Transfer Profile (WPTP) Specification

Compatible boards:
Bl RSL10 Evaluation Board

Components Packs

Figure 54. Accessing RSL10 Documentation from the onsemi IDE
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File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

113Lﬂ|5| 5 ﬁ5|‘7 “' .Eff’_f.ff=|@ co_rand
|§‘Iﬂlﬁ|@' |%’Q|Targe‘tl @
Books Lo
=il Device Data Books -

-8 RSL10 Firmware Reference

@ RSL10 Hardware Reference
-4 RSL10 Sample Code User's Guide
@ Getting Started with RSL10
& ARM and Thumb-2 Instruction Set Quick Reference Card

@ Gap Interface Specification
@ GATT Interface Specification
-8 | 2C Interface Specification

@ RW BLE Alert Natification Profile Interface Specification
-4 RW BLE Battery Service Interface Specification
- RW BLE Blood Pressure Profile (BLP) Interface Specification
- RW BLE Cycling Power Profile Interface Specification

@ RW BLE Cycling Speed and Cadence Profile Interface Specification
- RW BLE Device Information Service Interface Specification
~&® RW BLE Find Me Profile Interface Specification
.- RW BLE Glucose Profile (GLP) Interface Specification

@ RW BLE HID Over GATT Profile Interface Specification
- RW BLE Heart Rate Profile (HRP) Interface Specification
- RW BLE Health Thermometer Profile Interface Specification

@ RW BLE Host Error Code Interface Specification
-4 RW BLE Location and Navigation Profile Interface Specification
- RW BLE Phone Alert Status Profile Interface Specification Interface Specification
& RW BLE Proximity Profile Interface Specification

& RW BLE Running Speed and Cadence Profile Interface Specification
- RW BLE Scan Parameters Profile Interface Specification
-8 RW BLE Time Profile (TIP) Interface Specification

@ RW BLE Wireless Power Transfer Profile (WPTP) Specification
=il Board Data Books

"4 RSL10 Evaluation and Development Board Manual (RSL10 Evaluation Board)

| Project |@Bouks |{1 Functions []+TE'“|F|&'_EE

Figure 55. Accessing RSL10 Documentation from the Keil uVision IDE
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LE - B Emnedied Workbench CHSES Mana i Vs s T El
File S Search CMSIS Mansger Window Help

Qrigvil vl - &

# by rteconty O @Packs 70 Devices B Boseds T Examples © Console : < z

Chenge Pack Action Descrigition
4 ® Devico Specific 1Pack RSLIO sedected
% ONSemmonductoeRSLI0 8 Undaidal ON Semicondctor RSLIO Device Family Pack
* Genenic

<13 ARM Cartex-M3

Max Clacic 48 M-z

Memory: 24 kB RAM, 354 kB ROM
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Figure 56. Accessing RSL10 documentation from the IAR Embedded Workbench
For more information, see the following:

Arm and Thumb®-2 Instruction Set Quick Reference Card

From the Arm company, this quick reference card provides a short-hand list of instructions for
the Arm Cortex-M3 processor.

RSL10 Evaluation and Development Board Manual

This document actually contains a link to the manual that is stored elsewhere on the website. It
is a reference manual that provides detailed information on the configuration and use of the
RSL10 Evaluation and Development Board. When you use this board with the software

development tools, you can test and measure the performance and capabilities of the RSL10
radio SoC.

RSL10 Firmware Reference

The system firmware provides functionality that isolates you from the hardware, and
implements complex but common tasks, making it easier to support and maintain your code.
The Bluetooth firmware provides an implementation of the Bluetooth host, controller, and
profiles, supporting the standards-compliant use of these components within your application.
This manual provides a reference to both sets of firmware features, and explains how they can
assist with the development of your applications.
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RSL10 Hardware Reference
Describes all the functional features provided by the RSL10 SoC, including how these features
are configured and how they can be used. This manual is a good place to start when you are
designing real-time implementations of your algorithms. or planning a product based on the
RSL10 SoC.

RSL10 Sample Code User’s Guide
Explains how to use the sample applications provided with the RSL10 software development
tools. You learn about setting up your system, accessing code files, and how the sample
applications work, using the Peripheral Device with Server sample code as the prime example.

RivieraWaves Interface Specifications (files in the ceva folder)
Interface Specifications from RivieraWaves provide a description of the API for the specified
library:

* GAP Interface Specification

* GATT Interface Specification

* Host Error Code Interface Specification

* L2C Interface Specification

* RW BLE Alert Notification Profile Interface Specification

* RW BLE Battery Service Interface Specification

* RW BLE Blood Pressure Profile (BLP) Interface Specification

* RW BLE Cycling Power Profile Interface Specification

* RW BLE Cycling Speed and Cadence Profile Interface Specification
* RW BLE Device Information Service Interface Specification

* RW BLE Find Me Profile Interface Specification

* RW BLE Glucose Profile (GLP) Interface Specification

* RW BLE HID Over GATT Profile Interface Specification

* RW BLE Heart Rate Profile (HRP) Interface Specification

* RW BLE Health Thermometer Profile Interface Specification

* RW BLE Location and Navigation Profile Interface Specification

* RW BLE Phone Alert Status Profile Interface Specification

* RW BLE Proximity Profile Interface Specification

* RW BLE Running Speed and Cadence Profile Interface Specification
* RW BLE Scan Parameters Profile Interface Specification

* RW BLE Time Profile (TIP) Interface Specification

* RW BLE Wireless Power Transfer System Profile Interface Specification

LPDSP32 Documentation
The following documents are available in the RSL10_LPDSP32_Support.zip file:

» RSL10 Getting Started with the LPDSP32 Processor, which provides an overview of the
techniques involved when writing and integrating code for the LPDSP32 processor that is on
RSL10.

» LPDSP32-V3 Block Diagram, which provides a drawing of all the inputs, outputs,
components and process blocks

» LPDSP32-V3 Hardware Reference Manual, which describes the hardware aspects of the
LPDSP32-V3 core and its operations to provide an understanding of the core architecture and
various kinds of supported operations.

» LPDSP32-V3 Interrupt Support Manual, which describes how interrupts are supported.
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» User Guide IP Programmers for LPDSP32-V3, which describes the C application layer, the
flow generally followed when any application is ported to LPDSP32, various tips for
optimization to make the best use of the processor and compiler resources, and certain things
the programmers should be aware of when porting applications. It also provides a few
examples to show the usage of LPDSP32 intrinsic functions and to give an idea of how
certain DSP functions can be ported to and optimized for LPDSP32.

RSL10 Release Notes
Lists new features in the latest release and known issues. This file is downloaded with the
installer in a zip file, and is not in the documentation folder.

8.2.2 Documentation in the RSL10 Documentation Package

You can access documentation through the RSL10 DOCUMENTATION PACKAGE.ZIP file available with this
release of RSL10. It contains all of the documents included with the CMSIS-Pack as well as the following:

Getting Started with RSL10 Bluetooth Low Energy Mesh
Helps you to get started with the RSL10 mesh package. It guides you through the process of
installing the mesh package alongside the RSL10 SDK, configuring your environment, and
building and debugging your first RSL10 mesh network.

RSL10 Bluetooth Low Energy Mesh Sample Code User’s Guide
Shows you what the mesh sample application (ble_mesh) demonstrates, how to configure the
project to set up different mesh network scenarios, and how to experiment with them to verify
their features and operations.

Files in the mindtree folder (related to Bluetooth Low Energy Mesh networking)
« EtherMind_Mesh_APIl.chm
» EtherMind_Mesh_Application_Developer's_Guide_Generic.pdf
» EtherMind_Mesh_CLI_User_Guide.pdf

RSL10 Bootloader Guide
The RSL10 bootloader provides means of performing firmware updates using the UART
interface, and is a required component for Firmware Over the Air (FOTA). The bootloader
enables firmware updates without the use of the JTAG interface. Firmware can be loaded from a
host microcontroller over UART or over the air from another wireless device using FOTA. The
bootloader copies the firmware image to the designated location in flash memory. This
document describes the bootloader firmware application and development tools.

RSL10 Firmware Over-The-Air User’s Guide
This manual describes Firmware Over-The-Air (FOTA) with RSL10. It provides the
prerequisites and instructions necessary to develop FOTA-ready firmware applications and to
perform FOTA updates in the field.

RSL10 LPDSP32 Support Manual
Provides an overview of the techniques involved when writing and integrating code for the
LPDSP32 processor included with the RSL10 radio System-on-Chip (SoC).

RSL10 Getting Started with the LPDSP32 Processor
Provides an overview of the techniques involved when writing and integrating code for the
LPDSP32 processor that is on RSL10.
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Manuals in the Ipdsp32 folder:

» LPDSP32-V3 Block Diagram: provides a drawing of all the inputs, outputs, components and
process blocks

» LPDSP32-V3 Hardware Reference Manual: Describes the hardware aspects of the
LPDSP32-V3 core and its operations to provide an understanding of the core architecture and
various kinds of supported operations

» LPDSP32-V3 Interrupt Support Manual: Describes how interrupts are supported

» User Guide IP Programmers for LPDSP32-V3: Describes the C application layer, the flow
generally followed when any application is ported to LPDSP32, various tips for optimization
to make the best use of the processor and compiler resources, and certain things the
programmers should be aware of when porting applications. It also provides a few examples
to show the usage of LPDSP32 intrinsic functions and to give an idea of how certain DSP
functions can be ported to and optimized for LPDSP32.

RSL10 Stand Alone Flash Loader Manual
Provides the information that you need to use the stand-alone flash loader. It describes the
operations that the flash loader can perform, and explains how to configure the flash loader to
connect to an RSL10 radio IC. The stand-alone flash loader is used to program, erase and read
flash memory in RSL10.
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APPENDIX A
Migrating to CMSIS-Pack

If you have an existing project and have not used the RSL.10 CMSIS-Pack before, this section is for you. Starting
from SDK 3.0, the RSL10 firmware is no longer bundled with the Eclipse IDE. The RSL10 Eclipse IDE has been
optimized and rebranded as the onsemi IDE, and the RSL10-specific firmware is now delivered exclusively as a
separate CMSIS-Pack that can be imported into the IDE. For future RSL10 releases, you only need to download and
import the updated CMSIS-Pack. There is no need to re-install the Eclipse IDE if it has not been updated.

Existing Eclipse project files from previous SDK releases are not compatible with the new onsemi IDE.
Fortunately, migrating your existing project into the new IDE to take advantage of the CMSIS-Pack standard is a
straightforward process, as shown in the next section.

A.1 MIGRATING AN EXISTING ECLIPSE PROJECT TO THE CMSIS-PACK METHOD

In order to tell whether your project is managed by CMSIS-Packs, check that a file with the .rteconfig extension
is present in the project folder. If not, your project is not managed by CMSIS-Packs and needs to be migrated. The
easiest way to migrate your existing Eclipse project to the new IDE is to start from one of the CMSIS-Pack RSL10
sample projects, and follow these steps:

NOTE: This section assumes you know how to import the CMSIS-Pack and a sample application, as
shown in Chapter 3, “Getting Started with the Eclipse-Based onsemi IDE” on page 8.

1. Decide on which CMSIS-Pack sample project to import. It is best to import a CMSIS-Pack project that looks

similar (in terms of libraries used) to the existing project you would like to migrate. For example, if your

existing application uses the Heart Rate Profile, you might want to import the ble_peripheral_server_hrp
sample application as a reference.

Right-click the project and rename it as you wish.

Remove the source code from the sample project.

Copy over the source and header files from your existing project into the new one.

Open the RTE Configuration Wizard by double-clicking the .rteconfig file, and make sure all the software

components (libraries) required for your project are selected.

*  Pay special attention to the Bluetooth components, such as the Bluetooth Low Energy Stack, Kernel,
and Profiles. Ensure that these components have the correct variants selected (such as release;-
release—tight; or release_hci).

*  Some libraries might have been removed, such as the weakprf.a. This library has been replaced by the
stubprf.c file that is automatically added together with the Bluetooth Low Energy Stack component, so
you no longer need to explicitly reference it.

*  You can also remove (deselect) the software components that you do not need in your existing
application.

» Ifyou change the .rteconfig file, make sure to save it, so that it can update your project settings
automatically (such as the library paths, includes, etc.) to reflect the newly added or removed software
components.

nRewD

6. Navigate to your project settings and add or remove the preprocessor symbol or include folders from your
existing project.
7. Build your application and make sure it builds correctly.
*  In case of build errors related to missing components, files, or preprocessor symbols, go back to steps 5
and 6 and review your configuration carefully.
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+ If you encounter errors related to duplicated code, review the RTE folder in your application. Some files
that were common to multiple sample applications have been transformed into software components, such
as the BLE Abstraction, CMSIS-Drivers, etc.

*  For errors related to deprecated code or API changes, review the latest RSL10 CMSIS-Pack release notes
and check to see if there are any feature changes that could affect your project.

A.2 USING THE LATEST RSL10 FIRMWARE IN A PREVIOUS VERSION OF THE ECLIPSE-BASED IDE

We recommend always updating your installation to the latest version of the Eclipse-based onsemi IDE. However,
if your circumstances are such that this is impractical, you can manually update the RSL10 firmware files in a previous
version of the Eclipse-based IDE. If this is your case, try the following steps:

1. Download the RSL10 Software Package from www.onsemi.com/RSL10 and extract the RSL10 CMSIS-Pack
(ONSemiconductor.RSL10.<version>.pack) to any temporary folder.

2. Use a compressing tool, such as 7-Zip, and extract the contents of the
ONSemiconductor.RSL10.<version>.pack file.

3. Copy and replace the lib and include folders from the CMSIS-Pack into your existing RSL10 SDK Installation
folder.

4. Clean and build your application. If the build has been successful, you can see that it now references the
updated libraries and include files.

In case of build errors, make sure to review the latest release notes from the CMSIS-Pack and check to see if
there are any features or bug fixes that affect your application.
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APPENDIX B
Arm Toolchain Support

There are several ways in which the onsemi IDE determines which Arm GNU toolchain to use when building.
Understanding how this works can help prevent confusion and frustration, when the development machine has several
versions of GNU toolchains installed.

B.1 BASIC INSTALLATION

The onsemi IDE supports the Arm toolchain by installing it in the arm_tools directory within the installed RSL10
software tools location. The build tools RM and Make are also included with the toolchain, to allow for an easier
building experience out of the box.

When the user starts the onsemi IDE with the IDE.exe program (whose shortcut is located in Windows menu
items), the arm_tools\bin directory is added to the path, to give the onsemi IDE access to the toolchain installed with
the RSL10 software tools.

Conflicts with toolchain versions can occur in the onsemi IDE, if an Arm-based toolchain has been installed
elsewhere or already exists on the path, and the IDE selects that toolchain rather than the one included in arm_tools.

B.2 CONFIGURING THE ARM TOOLCHAIN IN THE ONSEMI IDE

All toolchain location options can be accessed by right clicking on the project in the Project Explorer view,
selecting Properties at the bottom of the pop-up menu, and choosing the Toolchains tab. The scope of the toolchain
path support is described below.

Global Path: This is the path used by all workspaces/projects. The global path can be set in the Toolchains
tab of the project.

Workspace Path: This is the path used by all projects in the current workspace.
Project Path: This is the path used by the current project for its toolchain.

B.3 ADDITIONAL SETTINGS
Additional settings (other than the toolchain paths) are located within the MCU preference. These are:
*  The Build Tools path (global, workspace, project-based) for tools such as Make and RM

*  The Segger J-Link path (global, workspace, project-based) for the location of the Segger J-Link executables.
This replaces the Run/Debug string substitutions for J-Link previously used.
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